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agreement or non-disclosure agreement, no part of this document or the software described in this document may be 
reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, or otherwise, 
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About this Book and the Library

The Administrator Guide provides conceptual information about the NetIQ Aegis product (Aegis). 
This book defines terminology and various related concepts. It also provides step-by-step guidance 
for many configuration tasks.

Intended Audience
This book provides information for individuals responsible for any of the following tasks:

Understanding Aegis concepts
Installing Aegis
Configuring Aegis

Other Information in the Library
The library provides the following information resources:

Process Authoring Guide 
Provides conceptual information related to the Workflow Designer console and step-by-step 
guidance for many Process Author tasks.

User Guide 
Provides conceptual information related to the Operations Console and step-by-step guidance 
for many Process Operator tasks.

NetIQ Reporting Center Reporting Guide 
Provides conceptual information about the NetIQ Reporting Center product (Reporting Center). 
Intended for individuals responsible for understanding and using Aegis reports.

Help for Configuration Console 
Provides context-sensitive information and step-by-step guidance for common tasks, as well as 
definitions for each field on each window.

Help for Operations Console 
Provides conceptual information and step-by-step guidance for common tasks.
About this Book and the Library 7
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About NetIQ Corporation

NetIQ, an Attachmate business, is a global leader in systems and security management. With more 
than 12,000 customers in over 60 countries, NetIQ solutions maximize technology investments and 
enable IT process improvements to achieve measurable cost savings. The company’s portfolio 
includes award-winning management products for IT Process Automation, Systems Management, 
Security Management, Configuration Audit and Control, Enterprise Administration, and Unified 
Communications Management. For more information, please visit www.netiq.com.

Contacting Sales Support
For questions about products, pricing, and capabilities, please contact your local partner. If you 
cannot contact your partner, please contact our Sales Support team

.

Contacting Technical Support
For specific product issues, please contact our Technical Support team.

Contacting Documentation Support
Our goal is to provide documentation that meets your needs. If you have suggestions for 
improvements, please email Documentation-Feedback@netiq.com. We value your input and look 
forward to hearing from you.

Worldwide: www.netiq.com/about_netiq/officelocations.asp

United States and Canada: 888-323-6768 

Email: info@netiq.com

Web Site: www.netiq.com

Worldwide: www.netiq.com/Support/contactinfo.asp

North and South America: 1-713-418-5555 

Europe, Middle East, and Africa: +353 (0) 91-782 677

Email: support@netiq.com

Web Site: www.netiq.com/support
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Contacting the Online User Community
Qmunity, the NetIQ online community, is a collaborative network connecting you to your peers and 
NetIQ experts. By providing more immediate information, useful links to helpful resources, and 
access to NetIQ experts, Qmunity helps ensure you are mastering the knowledge you need to realize 
the full potential of IT investments upon which you rely. For more information, please visit
http://community.netiq.com. 
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1 1Introduction

IT operations managers are under increasing pressure to control costs while delivering services at a 
faster pace than ever before. In the quest to get “more for less,” many IT professionals are exploring 
ways to automate time-consuming, labor-intensive tasks that increasingly occupy valuable and 
expensive IT staff resources.

Many enterprises seek to automate routine workflow practices at the level of specific tasks and 
procedures, sometimes referred to as run books. While run books represent proven manual 
processes, they are subject to human error and can be very expensive by wasting expert staff time on 
repetitive, menial tasks. Run books can also be abstract, representing “tribal knowledge” that resides 
with individuals. Tribal knowledge may not be accurately recorded and can be easily lost when 
individuals leave an organization.

At the same time, IT operations deal with an increasingly diverse and complex IT environment due 
to highly distributed operations and business acquisitions. Often, these operational environments 
contain many diverse tools. The lack of integration for these tools can hinder the ability to efficiently 
respond to events and conduct routine operational activities.

NetIQ designed Aegis from the ground up as an IT workflow automation platform, to enable the 
automation of IT run books and processes.

1.1 What is Aegis?
Aegis is an IT process automation platform that allows you to model, automate, measure, and 
continuously improve run books and processes. Aegis allows you to:

Define automated IT processes, using your documented IT processes and run books as the 
foundation for automation
Automatically execute process steps on behalf of personnel
Coordinate work between different IT functions

Integrating with other NetIQ enterprise products, Aegis retrieves normalized information from your 
operations management systems to provide a cohesive “big picture” view of your IT operation 
processes.

By aggregating this information into a central console, Aegis lets IT operations personnel more easily 
accomplish the following objectives:

Automatically initiate standard IT processes to address incidents
Document all response activities
Report on adherence to accepted IT policies
Provide a complete audit history of incident management

By allowing users to quickly identify and automatically group and suppress related events, Aegis 
reduces the number of false positives users must address and manage.
Introduction 11



1.2 How Aegis Works
Aegis funnels information from data sources into a central repository, evaluating incoming data 
against processes that your team defines to match your IT policies. A process runs automatically 
when event information matches its trigger criteria. If user input is required, the user logs on to the 
Operations Console to tell the process what to do. For example, if temporary file growth causes disk 
space to fall below threshold, Aegis can command NetIQ AppManager to perform disk cleanup.

In this example, AppManager detects that available disk space has fallen below threshold and 
generates an event, which triggers a process in Aegis and creates a work item (an instance of a 
running process). Aegis requests a disk usage analysis from AppManager, identifying the top N 
culprits by folder, file type, and age, with extra attention paid to known temporary file storage areas. 
Aegis sends an email with the results of the analysis to the appropriate user, requesting approval to 
perform disk cleanup. The email includes a link to the Operations Console. The user logs on to the 
Operations Console and approves partial cleanup. Aegis commands AppManager to delete the 
approved files and analyze new disk space status. Aegis waits for confirmation of success, which it 
then sends to the user. Aegis closes the work item.

Aegis processes are flexible. A typical process may automatically complete the following types of 
steps:

Check for auxiliary information about the event
Determine the priority and urgency of the problem
Allow users to drill down for details about the event stream
12 NetIQ Aegis Administrator Guide



2 2Installing Aegis

These topics guide you through the Aegis installation process.

2.1 Implementation Checklist
The following checklist outlines the complete planning and installation process for Aegis.

Checklist Items

1. Review product architecture information to learn about Aegis components. For more 
information, see Section 2.2.3, “Understanding Aegis Components,” on page 15.

2. Ensure the computers on which you are installing Aegis meet the specified requirements. For 
more information, see the following:

Section 2.2.10, “Planning to Install the Databases,” on page 22

Section 2.2.12, “Planning to Install Aegis Server Components,” on page 24

Section 2.2.13, “Planning to Install Web Server Components,” on page 25

Section 2.2.14, “Planning to Install the Reporting Center Console,” on page 27

Section 2.2.15, “Planning to Install the Configuration Console,” on page 28

Section 2.2.16, “Planning to Install the Aegis Event Generator,” on page 28

3. Install Aegis. For more information, see Section 2.4, “Installing Aegis Components in a Non-
Cluster Environment,” on page 30 or Section 2.5, “Installing Aegis Components in a Cluster 
Environment,” on page 35.
Installing Aegis 13



2.2 Planning Your Aegis Environment
This section provides requirements, details of supported configurations, and other information 
necessary for planning your Aegis installation environment.

2.2.1 Determining Installation Type
The Aegis setup program does not require a license key for installation. By default, the setup 
program installs a fully functional installation with a trial license that allows you to evaluate Aegis 
for 30 days. After 30 days, Aegis provides a 30-day grace period, during which you see a notification 
of the grace period each time you log on to Aegis. The environment in which you install Aegis 
determines the installation type.

Trial Environment 
You can evaluate Aegis in a “full trial” environment that meets production environment 
prerequisites or in a “proof of concept” environment that does not meet production standards. 
For more information about configuring a full trial environment, see Section 2.2.6, “Supported 
Configurations,” on page 19.

Production Environment 
When you deploy Aegis in your production environment, you can install the production license 
key in the Configuration Console immediately after installation or at any time during the 30-day 
trial period. For more information about obtaining license keys, contact your NetIQ sales 
representative.
Ensure you plan ahead for your production environment. Aegis supports taking a full trial 
environment to a production license key. However, Aegis does not support automated 
migration from a proof of concept environment to a production environment. If you wish to 
migrate from a proof of concept environment to a production environment, NetIQ recommends 
you install a new Aegis configuration in your production environment and use the export and 
import features in Aegis to manually migrate activity libraries and process customizations. For 
more information about configuring your production environment, see Section 2.2.6, 
“Supported Configurations,” on page 19.

2.2.2 Licensing
Aegis requires a license key that allows you to use the product. The Aegis setup program 
automatically installs a trial license key that expires 30 days after installation, with an additional 30-
day grace period.

After installation, you can add a production license key at any time during the 30-day trial. For more 
information about taking a trial licensed environment to a production license key, see Section 2.2.1, 
“Determining Installation Type,” on page 14.

Use the Licenses list in the Configuration Console to manage the licenses in your Aegis environment.

Aegis supports the following types of production licenses:

Full License 
Aegis allows you to create and run any number of processes in your production environment.

Per Process License 
Aegis allows you to create any number of processes, but allows you to run only a specific 
number of processes in your production environment. The processes can be associated with 
multiple Aegis adapters.
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Signed Process License 
Aegis allows you to run signed processes from NetIQ in your production environment. Signed 
processes address specific needs, and do not affect the number of processes you can run with the 
Per Process license. You cannot modify signed processes.

For more information about obtaining license keys, contact your NetIQ sales representative.

2.2.3 Understanding Aegis Components
Aegis includes a number of software components that you should plan to install strategically over a 
number of computers. The following diagram displays a three-tier configuration in a non-cluster 
environment. For more information about supported configurations, see Section 2.2.6, “Supported 
Configurations,” on page 19.

Aegis includes the following major components:

Operations Console 
A Web-based user interface that accesses the Operations Web site on the Web Server computer. 
The Operations Console allows Process Operators to:

Monitor active work items and view their details
Investigate information from data sources and appended events
Provide remediation input

For more information about Process Operators and their responsibilities, see Section 4.1, 
“Managing Users and Groups,” on page 57.
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Configuration Console 
A Windows-based user interface delivered to a user’s desktop using Microsoft ClickOnce 
publishing and deployment technology. The Configuration Console allows users to:

Configure Aegis
Create processes
Define assets
Specify user and group permissions
Provide email content for notifications

The Configuration Console also includes a built-in Workflow Designer, which Process Authors 
use to define the steps in a process. For more information about Process Authors and their 
responsibilities, see Section 4.1, “Managing Users and Groups,” on page 57.

Reporting Center Console 
A Windows-based reporting tool for Aegis installed locally for each user that runs reports. For 
more information, see the Reporting Guide for NetIQ Reporting Center.

NetIQ Aegis Business Services Layer (BSL) 
A Web service that allows the Operations Console and the Configuration Console to 
communicate with the Aegis Server computer.

Reporting Center Web Service 
A Web service that allows the Reporting Center Console to communicate with the Reporting 
Center database and retrieve report data from the Aegis and Resource Management databases.

Aegis Services 
A set of services on the Aegis Server computer that manage the workflows in production.

The NetIQ Aegis Engine (Aegis Engine) receives events from adapters and sends them to 
the Correlation Engine for evaluation. After the evaluation, the Aegis Engine initiates work 
items from process workflows and executes workflow activities. This service depends on 
the NetIQ Aegis Namespace Provider (current or pre-2.2) and the NetIQ Resource 
Management Namespace Provider.
The NetIQ Aegis Correlation Engine (Correlation Engine) receives events from the Aegis 
Engine and determines whether the events match any triggers.
The NetIQ Aegis Activity Broker (Activity Broker) allows the Aegis Engine to execute 
workflow activities. This service depends on the NetIQ Aegis Namespace Provider (current 
or pre-2.2).

Providers 
A set of components on the Aegis Server computer that facilitate communication with the 
databases for both the BSL and the Aegis services.

The NetIQ Aegis Namespace Provider communicates with the Aegis database and runs 
adapters. Core adapters implement base Aegis functionality, such as scheduled events and 
monitoring email accounts. Product adapters extend Aegis functionality by allowing Aegis 
to communicate with data sources, such as BMC Remedy and NetIQ AppManager. This 
version of the Aegis Namespace Provider is present in both cluster and non-cluster 
environments.
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The NetIQ Aegis Namespace Provider (pre-2.2) communicates with the Aegis database 
and runs older versions of product adapters released prior to Aegis 2.2. This version of the 
Aegis Namespace Provider is not present in a cluster environment.
The NetIQ Resource Management Namespace Provider communicates with the Resource 
Management database to provide centralized access to the resource, user, and security data 
in Aegis.

Adapters 
A set of components on the Aegis Server computer that facilitate communication between the 
Aegis Namespace Provider and data sources. For a complete list of Aegis adapters, see the Aegis 
support site available at http://support.netiq.com/aegis.

Aegis Database 
Microsoft SQL Server database that stores all Aegis information, such as processes, work items, 
workflows, and supporting analysis.

Resource Management Database 
Microsoft SQL Server database (display name: IQRM) that stores information needed to display 
resource data such as business services, users, and computers. It is typically installed on the 
Database Server computer with the Aegis and Reporting Center databases. You can install it on a 
separate Resource Management server computer if your environment has multiple NetIQ 
products that use the same Resource Management database.

Reporting Center Database 
Microsoft SQL Server database that stores information the Reporting Center Console needs to 
display reports. It is typically installed on the Database Server computer with the Aegis and 
Resource Management databases. You can install it on a separate Reporting server computer if:

Your environment has multiple NetIQ products that use the same Reporting Center 
database.
You plan to use Aegis in a cluster environment. The Reporting Center database does not 
support clusters.

2.2.4 Restarting Aegis Services
The Aegis services need to start in a certain order. If you need to restart one or more Aegis services, 
use the following list to determine the order:

1. NetIQ Resource Management Namespace Provider
2. NetIQ Aegis Namespace Provider
3. NetIQ Aegis Namespace Provider (pre-2.2)
4. NetIQ Aegis Engine
5. NetIQ Aegis Activity Broker
6. NetIQ Aegis Correlation Engine
7. NetIQ Aegis Business Services
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2.2.5 Understanding Aegis Application Credentials
During the installation process, the Aegis Administrator specifies the default user account and 
password for the Aegis application credentials.

NOTE: The user account must be a member of the local Administrators group on the Aegis Server 
computer.

The Aegis application credentials allow Aegis to operate the following accounts:

Aegis Service Account 
The account with which Aegis executes the following services on the Aegis Server computer:

Aegis Engine
Activity Broker
Aegis Namespace Provider

For best results, ensure the service account is a domain account. For more information about 
service account privileges, see “Trusted Domains” on page 21 and Section 4.1.2, “Understanding 
User and Group Synchronization,” on page 58.

Aegis Database Runtime Account 
The account with which Aegis connects to the Aegis database at run time. This account can be 
one of the following:

A SQL-only account you specify during the installation process
The Aegis service account

During the installation process, the Aegis setup program associates the specified account with 
the db_owner role on the Aegis database.

Resource Management Account 
The account with which Aegis adapters communicate with the Resource Management 
Namespace Provider.

Resource Management Database Runtime Account 
The account with which Aegis connects to the Resource Management database at run time. This 
account can be one of the following:

A SQL-only account you specify during the installation process
The Resource Management account

During the installation process, the Aegis setup program associates the specified account with 
the db_owner role on the Resource Management database.

Default Aegis Administrator Account 
The account the Aegis Administrator uses for the first Aegis logon. Aegis associates the account 
with the following Aegis groups:

Aegis Administrators
Aegis Users

For more information about the default Aegis groups, see Section 4.1.1, “Default Groups,” on 
page 57.

After installation, you can modify the user account associated with the Aegis application credentials 
at any time. For more information about modifying the Aegis application credentials, see Section 3.7, 
“Modifying Aegis Application Credentials,” on page 54.
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2.2.6 Supported Configurations
NetIQ recommends you install Aegis strategically over multiple computers in one of the following 
configurations.

NOTE

Installing all required components on one computer is not recommended.
Installing Aegis components on domain controllers is not recommended.

Two-Tier Configuration 
In a two-tier configuration, you distribute Aegis components across two server computers.
Database Server Computer 

Install the Aegis, Resource Management, and Reporting Center databases on one computer.
Combined Aegis Server/Web Server Computer 

Install the Aegis services, the Aegis Namespace Provider, the Resource Management 
Namespace Provider, any Aegis adapters, the Operations Web site, the BSL, and the 
Reporting Center Web service on one computer.

Three-Tier Configuration 
In a three-tier configuration, you distribute Aegis components across three server computers.
Database Server Computer 

Install the Aegis, Resource Management, and Reporting Center databases on one computer.
Aegis Server Computer 

Install the Aegis services, the Aegis Namespace Provider, the Resource Management 
Namespace Provider, and any Aegis adapters on one computer.

Web Server Computer 
Install the Operations Web site, the BSL, and the Reporting Center Web service on one 
computer.

Four-Tier Configuration 
In a four-tier configuration, you distribute Aegis and Resource Management components across 
four server computers. If you want to install Aegis in a cluster environment, you must install the 
Reporting Center database on a separate computer.
Database Server Computer 

Install the Aegis and Reporting Center databases on one computer.
Resource Management Server Computer 

Install the Resource Management database on one computer.
Aegis Server Computer 

Install the Aegis services, the Aegis Namespace Provider, the Resource Management 
Namespace Provider, and any Aegis adapters on one computer.

Web Server Computer 
Install the Operations Web site, the BSL, and the Reporting Center Web service on one 
computer.
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The following diagram displays a four-tier configuration in a cluster environment.

After you determine the configuration you want to use in your environment and install the 
appropriate components on the server computers, install the Reporting Center Console on each 
computer where users will run reports.

For more information about installing Aegis components, see Section 2.4, “Installing Aegis 
Components in a Non-Cluster Environment,” on page 30 or Section 2.5, “Installing Aegis 
Components in a Cluster Environment,” on page 35.

Firewall
If your environment requires a firewall between the BSL and the consoles, you must open an 
additional port in the firewall. If you want the BSL to use port 80 (443) to communicate with the 
consoles through a firewall, install the BSL on a separate computer from the Web Server computer. 
For more information about configuring the BSL to communicate through a firewall, contact NetIQ 
Technical Support.
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Trusted Domains
You can configure a Windows domain to trust one or more domains. A trust passes account 
authentication from one domain to another, allowing easier access to computers, resources, and data 
across domains. Trusts directly influence domain security, because if even one domain in a trust 
contains a vulnerability, all domains in that trust are open to attack.

Aegis supports one-way and two-way trusts. To ensure Aegis can synchronize and display trusted 
domain account information in a one-way trust, the Aegis service account must be:

A member of the Administrators group on the Aegis Server computer
Able to perform Active Directory domain queries across all domains from which users can log 
on to Aegis

Specify the appropriate Aegis service account during the installation process for the Aegis Server 
components. For more information about the Aegis service account, see Section 2.2.5, 
“Understanding Aegis Application Credentials,” on page 18. For more information about installing 
the Aegis Server components, see Section 2.2.12, “Planning to Install Aegis Server Components,” on 
page 24. For more information about synchronization, see Section 4.1.2, “Understanding User and 
Group Synchronization,” on page 58.

2.2.7 Planning to Install Aegis in a Cluster Environment
You can install all Aegis components except Reporting Center in a Microsoft Clustering Services 
cluster environment. If you want to install Aegis in a cluster environment, you must:

Create an Aegis-specific resource group for each cluster. A cluster resource group is not the 
same as a resource group in Aegis. For more information about resource groups in Aegis, see 
Section 5.1.1, “Understanding Resource Groups,” on page 63.
Install the Reporting Center database on a separate computer.

For more information about the requirements for creating the Aegis resource group and installing 
Aegis components in a cluster environment, see the following sections:

Section 2.2.10, “Planning to Install the Databases,” on page 22
Section 2.2.12, “Planning to Install Aegis Server Components,” on page 24
Section 2.2.13, “Planning to Install Web Server Components,” on page 25
Section 2.2.11, “Planning to Install Reporting Center in a Cluster,” on page 24

For more information about setting up a Microsoft Clustering Services cluster environment, see the 
appropriate Microsoft documentation

2.2.8 Default Ports
Open the ports listed in the following table for proper communication between Aegis components.

Port Number Component 
Computer Port Use

2219 Aegis Server 
computer

Used by the NetIQ Aegis Namespace Provider to run adapters. For 
more information about how the NetIQ Aegis Namespace Provider 
interacts with adapters, see Section 2.2.3, “Understanding Aegis 
Components,” on page 15.
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2.2.9 Supported Languages and Locales
Aegis supports English language versions of the Microsoft Windows operating system in the 
following locales:

English
Spanish
German
Japanese

2.2.10 Planning to Install the Databases
This section provides requirements, recommendations, and configuration information for the 
Database Server computer. For the most recent information about third-party software requirements, 
see the Aegis support site available at http://support.netiq.com/aegis.

Typically, the Database Server computer hosts the following databases:

Aegis database
Resource Management database
Reporting Center Configuration database

If you plan to install in a cluster environment, you must install the Reporting Center Configuration 
database on a separate reporting server. For more information about installing Reporting Center on a 
separate server, see Section 2.2.11, “Planning to Install Reporting Center in a Cluster,” on page 24.

2220 Aegis Server 
computer

Used by the NetIQ Aegis Namespace Provider (pre-2.2) to run 
adapters that were released prior to Aegis 2.2. For more information 
about how the NetIQ Aegis Namespace Provider (pre-2.2) interacts 
with adapters, see Section 2.2.3, “Understanding Aegis 
Components,” on page 15.

10117 Aegis Server 
computer

Used by the NetIQ Resource Management Namespace Provider. 
For more information about the NetIQ Resource Management 
Namespace Provider, see Section 2.2.3, “Understanding Aegis 
Components,” on page 15.

1433 Database Server 
computer

Used by the Aegis and Resource Management databases to 
communicate with the NetIQ Aegis Namespace Provider and NetIQ 
Resource Management Namespace Provider.

NOTE: If your environment uses separate computers for the Aegis 
and Resource Management databases, ensure port 1433 is 
available on both computers.

8091 (TCP)

8092 (HTTP)

Web Server 
computer

Used by the BSL to communicate with the Operations Console and 
the Configuration Console.

80 (HTTP)

443 (HTTPS)

Web Server 
computer

Used by the Web Server computer to allow remote users to log on to 
the Operations Console. The Web Server computer uses port 80 by 
default.

Port Number Component 
Computer Port Use
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The following table lists the requirements and recommendations for the Database Server computer:

NOTE

If you plan to install the Resource Management database on a separate Resource Management 
server computer, use the following requirements for both the Database Server computer and the 
Resource Management server computer.
In a cluster environment, these requirements apply to each node in the cluster.

Category Requirement

Processor 1.8 GHz Intel Pentium 4 server class with dual processor

Disk Space Two drive configuration:

System drive: 60 GB free disk space

Data drive: 200 GB free disk space

Memory 4 GB

Operating System One of the following:

Windows Server 2012

Windows Server 2008 R2

Windows Server 2008 Service Pack 2 or later (32- or 64-bit)

NOTE: If you install the databases remotely, the Aegis setup program does not 
validate the operating system on the remote computer.

Additional Software One of the following:

Microsoft SQL Server 2012 (32- or 64-bit)

Microsoft SQL Server 2008 R2 (32- or 64-bit)

Microsoft SQL Server 2008 (32- or 64-bit)

Microsoft SQL Server 2005 Service Pack 2 or later (32- or 64-bit)

Microsoft SQL Server Native Client for the installed version of 
Microsoft SQL Server

Microsoft SQL Server Reporting Services for the installed version of 
Microsoft SQL Server (non-cluster environment only)

Windows PowerShell 2.0 (required only for a cluster environment)

NOTE

Non-U.S. language versions of Microsoft SQL Server are not supported.

If you install the databases remotely, the Aegis setup program does not 
validate the version of Microsoft SQL Server on the remote computer.

Port 1433: Used by the Aegis Server computer and the Web Server computer to 
connect to the SQL Server databases.

For more information about the ports, see Section 2.2.8, “Default Ports,” on 
page 21.

Resource Group 
Configuration

If you plan to install in a cluster environment, you must create an Aegis-specific 
resource group.
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2.2.11 Planning to Install Reporting Center in a Cluster
Reporting Center does not support clusters. If you want to install Aegis in a cluster environment, you 
must install the Reporting Center database on a separate Reporting server computer.

In a cluster environment, the Reporting server computer hosts the following components:

Reporting Center Web service
Reporting Center Configuration database

For more information about the requirements for the Reporting server computer, see the Reporting 
Guide for NetIQ Reporting Center. For the most recent information about third-party software 
requirements, see the Aegis support site available at http://support.netiq.com/aegis.

2.2.12 Planning to Install Aegis Server Components
This section provides requirements, recommendations, and configuration information for the Aegis 
Server computer. For the most recent information about third-party software requirements, see the 
Aegis support site available at http://support.netiq.com/aegis.

Typically, the Aegis Server computer hosts the following components:

NetIQ Aegis Activity Broker service
NetIQ Aegis Correlation Engine service
NetIQ Aegis Engine service
NetIQ Aegis Namespace Provider
NetIQ Resource Management Namespace Provider
Aegis adapters

The following table lists the requirements and recommendations for the Aegis Server computer.

NOTE

If you are installing Aegis in a two-tier configuration, ensure the computer where you want to 
install the combined Aegis Server and Web Server components meets the requirements for both. 
For more information about Web Server computer requirements, see Section 2.2.13, “Planning to 
Install Web Server Components,” on page 25.
In a cluster environment, these requirements apply to each node in the cluster.

Category Requirement

Processor 1.8 GHz Intel Pentium 4 server class with dual processor

Disk Space Two drive configuration:

System drive: 60 GB free disk space

Data drive: 80 GB free disk space

Memory 4 GB
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2.2.13 Planning to Install Web Server Components
This section provides requirements, recommendations, and configuration information for the Web 
Server computer. For the most recent information about third-party software requirements, see the 
Aegis support site available at http://support.netiq.com/aegis.

Group Policy Settings
Before installing the Web Server components, ensure you configure the Group Policy security 
settings on the Web Server computer to allow anonymous access.

Web Server Computer Requirements
Typically, the Web Server computer hosts the following components:

Operations Web site
BSL
Reporting Center Web service

Operating System One of the following:

Windows Server 2012

Windows Server 2008 R2

Windows Server 2008 Service Pack 2 or later (32- or 64-bit)

Additional Software Microsoft Message Queuing 3.0, 4.0, 5.0, or 6.0

Microsoft .NET Framework 3.0 or 3.5 *

Microsoft SQL Server Native Client for the version of Microsoft SQL Server 
installed on the Database Server computer

Windows PowerShell 2.0 **

* The Aegis Server components do not use Microsoft .NET Framework 4.0 or 4.5, 
but .NET Framework 3.x and 4.x can coexist on the Aegis Server computer.

** The Aegis Server components do not use Windows PowerShell 3.0, but 
PowerShell 2.0 and 3.0 can coexist on the Aegis Server computer.

Ports 2219: Used by the NetIQ Aegis Namespace Provider to communicate with the 
Aegis database and run Aegis adapters.

2220: Used by the NetIQ Aegis Namespace Provider (pre-2.2) to run older versions 
of Aegis adapters that do not support clusters.

10117: Used by the NetIQ Resource Management Namespace Provider.

For more information about the ports, see Section 2.2.8, “Default Ports,” on 
page 21.

Resource Group 
Configuration

If you plan to install in a cluster environment, you must create an Aegis-specific 
resource group by clustering Microsoft Message Queuing 3.0, 4.0, 5.0, or 6.0. For 
more information about clustering Microsoft Message Queuing, see Section 2.5.3, 
“Clustering Microsoft Message Queuing on the Aegis Server Computer,” on 
page 38.

Category Requirement
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If you plan to install in a cluster environment, you must install the Reporting Center Web service on a 
separate reporting server. For more information about installing Reporting Center on a separate 
server, see Section 2.2.11, “Planning to Install Reporting Center in a Cluster,” on page 24.

The following table lists the requirements and recommendations for the Web Server computer:

NOTE

If you are installing Aegis in a two-tier configuration, ensure the computer where you want to 
install the combined Aegis Server and Web Server components meets the requirements for both. 
For more information about Aegis Server computer requirements, see Section 2.2.12, “Planning 
to Install Aegis Server Components,” on page 24.
In a cluster environment, these requirements apply to each node in the cluster.
Do not configure Network Load Balancing (NLB) on your Web Server cluster.

WARNING: When you configure Microsoft Internet Information Services (IIS) in a cluster 
environment, do not use the Shared Configuration option.

Category Requirement

Processor 1.8 GHz Intel Pentium 4 server class with dual processor

Disk Space 60 GB free disk space

Memory 4 GB

Operating System One of the following:

Windows Server 2012

Windows Server 2008 R2

Windows Server 2008 Service Pack 2 or later (32- or 64-bit)

Additional Software Microsoft Internet Information Services 6, 7, 7.5, or 8 *

One of the following versions of Microsoft ASP.NET:

If you are running IIS 6 or 7.x, ASP.NET 2.0, 3.0, or 3.5

If you are running IIS 8, ASP.NET 4.0

Microsoft .NET Framework 2.0 (for Reporting Center Web service only)

Microsoft .NET Framework 4.0 or 4.5 (required for all other components)

Windows PowerShell 2.0 (required only for a cluster environment)

* If you install IIS 7.x or 8, you must enable IIS 6 compatibility mode.

Ports 8091 and 8092: Used by the BSL to communicate with the Operations Console and 
the Configuration Console.

80 or 443: Used by the Web Server computer to allow remote users to log on to the 
Operations Console using HTTP or HTTPS.

For more information about the ports, see Section 2.2.8, “Default Ports,” on 
page 21.

Resource Group 
Configuration

If you plan to install in a cluster environment, you must create an Aegis-specific 
resource group.
26 NetIQ Aegis Administrator Guide



Operations Console Web Browser Computer Requirements
The following table lists the requirements and recommendations for each computer where users 
launch a Web browser to log on to the Operations Console.

Securing Your Aegis Environment
Aegis encrypts and authenticates all communication between the consoles, the BSL, the Aegis Server 
computer, and the databases. However, to secure communication between the Operations Console 
and the Web Server computer, you must use Secure Sockets Layer (SSL) for all Web Server computers 
in your Aegis environment. Otherwise, any person using a sniffer on your network could access 
passwords and other privileged information.

NOTE: In a cluster environment, ensure you import a certificate from a .pfx file instead of 
generating a temporary self-signed certificate. If you generate a temporary self-signed certificate on 
the node where you install the Web Server components, the certificate is available only on that node. 
The certificate is not available to the other nodes in the cluster.

For information about configuring SSL in Microsoft Certificate Services and in Microsoft Internet 
Information Services (IIS), see the Microsoft documentation.

Aegis uses the following technologies to secure your Web Server computer:

ASP.NET security provides application-level security for the Web Server computer. You can lock 
down the server using best practices for ASP.NET security.
Security features in IIS control access to the Web Server computer virtual directory.
The BSL authenticates connections between the Operations Console and an Aegis Server 
instance.

2.2.14 Planning to Install the Reporting Center Console
Install the Reporting Center Console on each computer where users will run Aegis reports. For more 
information about the requirements for the Reporting Center computer, see the Reporting Guide for 
NetIQ Reporting Center. For the most recent information about third-party software requirements, see 
the Aegis support site available at http://support.netiq.com/aegis.

Category Requirement

Operating System One of the following operating systems:

Windows 8 (32- or 64-bit)

Windows 7 (32- or 64-bit)

Windows Server 2008 R2

Windows Server 2008 Service Pack 2 or later (32- or 64-bit)

Windows Vista (32- or 64-bit)

Windows XP Service Pack 2 or later (32- or 64-bit)

Additional Software Microsoft Internet Explorer 7, 8, 9, or 10
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2.2.15 Planning to Install the Configuration Console
This section provides requirements, recommendations, and configuration information for each 
Configuration Console computer. For the most recent information about third-party software 
requirements, see the Aegis support site available at http://support.netiq.com/aegis.

NOTE: If your environment does not support the default ClickOnce deployment, you can install the 
Configuration Console locally for all Aegis Administrators and Process Authors. For more 
information about installing the Configuration Console locally, see Section 2.8, “Installing the 
Configuration Console Locally,” on page 43. For more information about installing the Configuration 
Console using ClickOnce deployment, see Section 3.10, “Starting the Configuration Console the First 
Time,” on page 55.

The following table lists the requirements and recommendations for each Configuration Console 
computer.

2.2.16 Planning to Install the Aegis Event Generator
This section provides requirements for each computer where you want to install the Aegis Event 
Generator. By default, the Aegis setup program installs the Aegis Event Generator on the Aegis 
Server computer. You can also install it on a remote computer. The Aegis setup program installs the 
Aegis Event Generator in the C:\Program Files\NetIQ\Aegis\IQConnect73\bin folder.

For the most recent information about third-party software requirements, see the Aegis support site 
available at http://support.netiq.com/aegis.

The following table lists the requirements and recommendations for each computer where you install 
the Aegis Event Generator.

Category Requirement

Operating System One of the following operating systems:

Windows 8 (32- or 64-bit)

Windows 7 (32- or 64-bit)

Windows Server 2008 R2

Windows Server 2008 Service Pack 2 (32- or 64-bit)

Windows Vista (32- or 64-bit)

Windows XP Service Pack 2 or later (32- or 64-bit)

Additional Software Microsoft .NET Framework 4.0 or 4.5

Category Requirement

Operating System One of the following operating systems:

Windows Server 2012

Windows Server 2008 R2

Windows Server 2008 Service Pack 2 or later (32- or 64-bit)
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2.3 Upgrading from a Previous Version
This section provides information to help you upgrade your existing NetIQ Aegis installation to 
Aegis 3.0. If you currently use Aegis 2.1, 2.2, or 2.3, you can upgrade to Aegis 3.0 using one of the 
following methods:

In-place upgrade
Migration to a new environment

2.3.1 Performing an In-Place Upgrade
An in-place upgrade allows you to:

Upgrade from a non-clustered Aegis 2.1 environment to a non-clustered Aegis 3.0 environment
Upgrade from a non-clustered Aegis 2.2 environment to a non-clustered Aegis 3.0 environment
Upgrade from a non-clustered Aegis 2.3 environment to a non-clustered Aegis 3.0 environment
Upgrade from a clustered Aegis 2.2 environment to a clustered Aegis 3.0 environment
Upgrade from a clustered Aegis 2.3 environment to a clustered Aegis 3.0 environment

NOTE: If you want to use Aegis 3.0 with 64-bit operating systems, and your current environment 
uses 32-bit operating systems, you must migrate your existing data to a new environment. For more 
information, see Section 2.3.2, “Migrating Your Existing Data to a New Environment,” on page 29.

To perform an in-place upgrade, simply run the Aegis setup program on your existing Aegis 
computers. For more information about installing Aegis and the order in which to install 
components, see Section 2.4, “Installing Aegis Components in a Non-Cluster Environment,” on 
page 30 or Section 2.5, “Installing Aegis Components in a Cluster Environment,” on page 35.

2.3.2 Migrating Your Existing Data to a New Environment
These steps guide you through the process of migrating the data from your existing installation to a 
new environment in the following scenarios:

Migrating from 32-bit environment to a 64-bit environment
Migrating from a non-cluster environment to a cluster environment

To migrate your existing data to a new environment:

1 In your current Aegis installation, stop the following services:
NetIQ Aegis Activity Broker service
NetIQ Aegis Correlation Engine service
NetIQ Aegis Engine service
NetIQ Aegis Namespace Provider

Additional Software Microsoft .NET Framework 3.0 or 3.5

NOTE: The Aegis Event Generator does not use Microsoft .NET Framework 4.0 or 
4.5, but .NET Framework 3.x and 4.x can coexist on the same computer.

Category Requirement
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NetIQ Aegis Namespace Provider (pre-2.2) (if you are upgrading from Aegis 2.2 or 2.3)
NetIQ Aegis Business Services Layer

2 On the Database Server computer for your current installation of Aegis, back up the following 
databases:

Aegis
IQRM

For more information about backing up databases, see the appropriate Microsoft 
documentation.

3 On the Database Server computer in your new environment, restore the databases. For more 
information about restoring databases, see the appropriate Microsoft documentation.

4 Run the Aegis setup program on the computers in your new environment using one of the 
following checklists:

(Conditional) If you are migrating to a non-cluster environment, see Section 2.4, “Installing 
Aegis Components in a Non-Cluster Environment,” on page 30.
(Conditional) If you are migrating to a cluster environment, see Section 2.5, “Installing 
Aegis Components in a Cluster Environment,” on page 35.

2.4 Installing Aegis Components in a Non-Cluster Environment
To successfully install Aegis, you must install the components in the correct order. The following 
checklist specifies the correct order for installing Aegis components in a non-cluster environment.

Checklist Items

1. If you are installing Aegis in a four-tier configuration, install the Resource Management 
database on a separate computer. For more information, see Section 2.4.1, “Installing the 
Resource Management Database in a Four-Tier Non-Cluster Environment,” on page 31.

2. Install the databases on the Database Server computer. You can run the setup program 
locally on the Database Server computer or from a remote computer. For more information, 
see Section 2.4.2, “Installing Database Server Components in a Non-Cluster Environment,” 
on page 31.

3. If you are installing Aegis in a three-tier configuration, install the Aegis Server 
components. For more information, see Section 2.4.3, “Installing Aegis Server Components in 
a Three-Tier Non-Cluster Environment,” on page 32.

4. If you are installing Aegis in a three-tier configuration, install the Web Server 
components. For more information, see Section 2.4.4, “Installing Web Server Components in 
a Three-Tier Non-Cluster Environment,” on page 33.

5. If you are installing Aegis in a two-tier configuration, install the Aegis Server and Web 
Server components. For more information, see Section 2.4.5, “Installing Aegis and Web 
Server Components in a Two-Tier Non-Cluster Environment,” on page 34.

6. If your Web Server computer is using the Windows Server 2008 operating system, 
configure IIS to support the Operations Console. For more information, see Section 2.6, 
“Configuring the Operations Console on Windows Server 2008,” on page 42.

7. Install the Reporting Center Console. For more information, see Section 2.7, “Installing the 
Reporting Center Console Locally,” on page 43.

8. (Optional) Install the Configuration Console locally. For more information, Section 2.8, 
“Installing the Configuration Console Locally,” on page 43.
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2.4.1 Installing the Resource Management Database in a Four-Tier Non-
Cluster Environment
These steps guide you through the process of installing the Resource Management database on a 
separate Resource Management server computer in a non-cluster environment.

If the Resource Management account is different from the Aegis service account and the default 
Aegis Administrator account, ensure you install the Resource Management database before you 
install any other Aegis components. For more information about the Resource Management account, 
see Section 2.2.5, “Understanding Aegis Application Credentials,” on page 18.

To install the Resource Management database in a four-tier non-cluster environment:

1 Log on with an Administrator account to the computer where you want to install the Resource 
Management database.

NOTE: You can also install the database remotely.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

3 Click Begin Setup.
4 On the Select Components window of the NetIQ Aegis Setup wizard, select Resource 

Management Database.

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

5 Click Next.
6 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the Resource 

Management database, and then click Finish.

2.4.2 Installing Database Server Components in a Non-Cluster Environment
These steps guide you through the process of installing the databases on the Database Server 
computer in a non-cluster environment. You can run the setup program locally on the Database 
Server computer or from a remote computer.

If the Resource Management account is different from the Aegis service account and the default 
Aegis Administrator account, ensure you install the Resource Management database before you 
install any other Aegis components. For more information about the Resource Management account, 
see Section 2.2.5, “Understanding Aegis Application Credentials,” on page 18.

To install Database Server components in a non-cluster environment:

1 Log on with an Administrator account to the computer where you want to install the databases.

NOTE: You can also install the databases remotely.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.
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3 Click Begin Setup.
4 If you are installing Aegis in a four-tier configuration, on the Select Components window of the 

NetIQ Aegis Setup wizard, select the following components:

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

Aegis Database
Aegis Reporting

5 If you are installing Aegis in a three-tier configuration, on the Select Components window of 
the NetIQ Aegis Setup wizard, select the following components:

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

Aegis Database
Aegis Reporting
Resource Management Database

NOTE: If you want to install the Resource Management database on a separate computer, you 
can specify the details of the remote Resource Management server computer during the 
installation process.

6 Click Next.
7 On the Prerequisites window, under Required Prerequisites, click NetIQ Reporting Center, 

and then click Install Prerequisite to start the NetIQ Reporting Center Setup wizard.
8 On the Feature Selection window of the NetIQ Reporting Center Setup wizard, select the 

following options:
Configuration Database
Reporting Services Data Extension

For more information about Reporting Center components, see the Reporting Guide for NetIQ 
Reporting Center.

9 Click Next.
10 Follow the instructions in the NetIQ Reporting Center Setup wizard until you finish installing 

the Reporting Center components, and then click Finish.
11 Follow the instructions in the NetIQ Aegis Setup wizard, and then click Finish.

2.4.3 Installing Aegis Server Components in a Three-Tier Non-Cluster 
Environment
These steps guide you through the process of installing the following components on the Aegis 
Server computer in a non-cluster environment:

NetIQ Aegis Activity Broker service
NetIQ Aegis Correlation Engine service
NetIQ Aegis Engine service
NetIQ Aegis Namespace Provider
NetIQ Aegis Namespace Provider (pre-2.2)
NetIQ Resource Management Namespace Provider
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To install Aegis Server components in a three-tier non-cluster environment:

1 Log on with an Administrator account to the computer where you want to install the Aegis 
Server components.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

3 Click Begin Setup.
4 On the Select Components window of the NetIQ Aegis Setup wizard, select the following 

options:

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

Aegis Services
Resource Management Namespace Provider

5 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the Aegis 
Server components, and then click Finish.

2.4.4 Installing Web Server Components in a Three-Tier Non-Cluster 
Environment
These steps guide you through the process of installing the following components on the Web Server 
computer in a three-tier non-cluster environment:

Operations Web site
BSL
Reporting Center Web service

To install Web Server components in a three-tier non-cluster environment:

1 Disable the firewall on the Aegis Server computer.
If you do not disable the firewall, the Aegis setup program might not be able to locate the Aegis 
Server computer during the Web Server computer installation.

2 Log on with an Administrator account to the computer where you want to install the Web Server 
components.

3 Configure the Group Policy security settings on the Web Server computer to allow anonymous 
access.

4 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

5 Click Begin Setup.
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6 On the Select Components window of the NetIQ Aegis Setup wizard, select the following 
components:

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

Web Server Components (complete feature)
Aegis Reporting

NOTE: In a non-cluster environment, the Aegis Reporting component installs the Reporting 
Center Web service.

7 Click Next.
8 On the Prerequisites window, under Required Prerequisites, click NetIQ Reporting Center, 

and then click Install Prerequisite to start the NetIQ Reporting Center Setup wizard.
9 On the Select Components window of the NetIQ Aegis Setup wizard, select Web Service, and 

then click Next.
For more information about Reporting Center components, see the Reporting Guide for NetIQ 
Reporting Center.

10 Follow the instructions in the NetIQ Reporting Center Setup wizard until you finish installing 
the Reporting Center Web service, and then click Finish.

11 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the Web 
Server components, and then click Finish.

12 Enable the firewall on the Aegis Server computer.

2.4.5 Installing Aegis and Web Server Components in a Two-Tier Non-
Cluster Environment
These steps guide you through the process of installing the following components on a combined 
Aegis/Web Server computer in a two-tier non-cluster environment:

NetIQ Aegis Activity Broker service
NetIQ Aegis Correlation Engine service
NetIQ Aegis Engine service
NetIQ Aegis Namespace Provider
NetIQ Aegis Namespace Provider (pre-2.2)
NetIQ Resource Management Namespace Provider
Operations Web site
BSL
Reporting Center Web service

To install Aegis Server and Web Server components in a two-tier non-cluster environment:

1 Log on with an Administrator account to the computer where you want to install the combined 
Aegis Server and Web Server components.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.
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3 Click Begin Setup.
4 On the Select Components window of the NetIQ Aegis Setup wizard, select the following 

options:

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

Aegis Services
Web Server Components (complete feature)
Aegis Reporting

NOTE: In a non-cluster environment, the Aegis Reporting component installs the Reporting 
Center Web service.

Resource Management Namespace Provider
5 Click Next.
6 On the Prerequisites window, under Required Prerequisites, click NetIQ Reporting Center, 

and then click Install Prerequisite to start the NetIQ Reporting Center Setup wizard.
7 On the Feature Selection window of the NetIQ Reporting Center Setup wizard, select Web 

Service, and then click Next.
For more information about Reporting Center components, see the Reporting Guide for NetIQ 
Reporting Center.

8 Follow the instructions in the NetIQ Reporting Center Setup wizard until you finish installing 
the Reporting Center Web service, and then click Finish.

9 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the combined 
server components and the databases, and then click Finish.

2.5 Installing Aegis Components in a Cluster Environment
To successfully install Aegis, you must install the components in the correct order. The following 
checklist specifies the correct order for installing Aegis components in a cluster environment.

Checklist Items

1. Install the Database Server computer components on the Database Server computer. You can 
run the setup program locally on the Database Server computer or from a remote computer. 
For more information, see Section 2.5.1, “Installing Database Server Components in a Cluster 
Environment,” on page 36.

2. Install the Reporting Center components on a separate Reporting server computer. For more 
information, see Section 2.5.2, “Installing Reporting Center in a Cluster Environment,” on 
page 37.

3. Create the Aegis-specific resource group on the Aegis Server computer by clustering 
Microsoft Message Queuing. For more information, see Section 2.5.3, “Clustering Microsoft 
Message Queuing on the Aegis Server Computer,” on page 38.

4. If you are installing Aegis in a three-tier configuration, install the Aegis Server 
components on the Aegis Server computer. For more information, see Section 2.5.4, 
“Installing Aegis Server Components in a Three-Tier Cluster Environment,” on page 38.
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2.5.1 Installing Database Server Components in a Cluster Environment
These steps guide you through the process of installing the databases on the Database Server 
computer in a cluster environment. You can run the setup program locally on the Database Server 
computer or from a remote computer.

NOTE

You only need to run the setup program on one node in the cluster. The setup program 
automatically installs the components on all other nodes in the cluster.
If you add a new node to the cluster, repeat these steps on the new node.

To install Database Server components in a cluster environment:

1 Log on with an Administrator account to the computer where you want to install the databases.
2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

3 Click Begin Setup.
4 On the Select Components window of the NetIQ Aegis Setup wizard, select the following 

components:

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

Aegis Database
Resource Management Database

5 If you want to change the location where the setup program installs Aegis, ensure you select a 
drive letter that exists on all nodes in the cluster, such as C:\. The setup program does not 
support installing Aegis on the drive you assigned to the Aegis resource group.

6 Click Next.

5. If you are installing Aegis in a three-tier configuration, install the Web Server components 
on the Web Server computer. For more information, see Section 2.5.5, “Installing Web Server 
Components in a Three-Tier Cluster Environment,” on page 39.

6. If you are installing Aegis in a two-tier configuration, install the Aegis Server and Web 
Server components on the combined Aegis/Web Server computer. For more information, see 
Section 2.5.6, “Installing Aegis and Web Server Components in a Two-Tier Cluster 
Environment,” on page 41.

7. Configure IIS on the Web Server computer. For more information, see Section 2.6, 
“Configuring the Operations Console on Windows Server 2008,” on page 42.

8. Install the Reporting Center Console on each user’s local computer. For more information, 
see Section 2.7, “Installing the Reporting Center Console Locally,” on page 43.

9. (Optional) Install the Configuration Console locally. For more information, Section 2.8, 
“Installing the Configuration Console Locally,” on page 43.

Checklist Items
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7 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the Aegis and 
Resource Management databases, and then click Finish.

8 To verify a successful installation, check the installation log file on each passive node in the 
cluster. Typically, the log file is in the c:\temp\Aegis folder.

9 If the installation process failed on a passive node, complete the following steps:
9a Run the Aegis setup program on the node where the installation failed.
9b Select Install Aegis on a new node in the cluster (existing Aegis installation).

2.5.2 Installing Reporting Center in a Cluster Environment
Reporting Center does not support clusters. If you want to install Aegis in a cluster environment, you 
must install the following Reporting Center components on a separate Reporting server computer:

Reporting Center Configuration Database
Reporting Services Data Extension
Reporting Center Web service

These steps guide you through the process of installing Reporting Center components on a separate 
Reporting server computer. For more information about Reporting Center components, see the 
Reporting Guide for NetIQ Reporting Center.

To install Reporting Center on a separate Reporting server computer:

1 Log on with an Administrator account to the computer where you want to install Reporting 
Center components.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

3 Click Begin Setup.
4 On the Select Components window of the NetIQ Aegis Setup wizard, select Aegis Reporting.
5 Click Next.
6 On the Prerequisites window, under Required Prerequisites, click NetIQ Reporting Center, 

and then click Install Prerequisite to start the NetIQ Reporting Center Setup wizard.
7 On the Feature Selection window of the NetIQ Reporting Center Setup wizard, select the 

following options:
Configuration Database
Reporting Services Data Extension
Web Service

8 Click Next.
9 Follow the instructions in the NetIQ Reporting Center Setup wizard until you finish installing 

the Reporting Center components, and then click Finish.
10 Follow the instructions in the NetIQ Aegis Setup wizard, and then click Finish.
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2.5.3 Clustering Microsoft Message Queuing on the Aegis Server Computer
These steps guide you through the process of clustering Microsoft Message Queuing on the Aegis 
Server computer (or the combined Aegis/Web Server computer), which creates an Aegis-specific 
resource group.

NOTE: A cluster resource group is not the same as a resource group in the Resource Management 
database. For more information about resource groups in Aegis, see Section 5.1.1, “Understanding 
Resource Groups,” on page 63.

To cluster Microsoft Message Queuing on the Aegis Server computer:

1 Log on with an Administrator account to the computer where you want to install the Aegis 
Server components.

2 Start Failover Cluster Manager.
3 In the left pane, right-click Services and applications, and then click Configure a Service or 

Application.
4 On the High Availability Wizard, click Select Service or Application.
5 Click Message Queuing, and then click Next.
6 Follow the instructions in the High Availability Wizard until you finish clustering Microsoft 

Message Queuing.

2.5.4 Installing Aegis Server Components in a Three-Tier Cluster 
Environment
These steps guide you through the process of installing components on the Aegis Server computer in 
a three-tier cluster environment.

NOTE

You only need to run the setup program on one node in the cluster. The setup program 
automatically installs the components on all other nodes in the cluster.
If you add a new node to the cluster, repeat these steps on the new node.

The setup program also creates cluster resources. The following table lists the components and their 
related cluster resources.

Component Related Cluster Resource

NetIQ Aegis Activity Broker service NetIQ Aegis Activity Broker

NetIQ Aegis Correlation Engine service [no related cluster resource]

NetIQ Aegis Engine service NetIQ Aegis Engine

NetIQ Aegis Namespace Provider NetIQ Aegis Namespace Provider

NetIQ Resource Management Namespace Provider NetIQ Resource Management Namespace Provider
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To install Aegis Server components in a three-tier cluster environment:

1 Log on with an Administrator account to the computer where you want to install the Aegis 
Server components.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

3 Click Begin Setup.
4 On the Select Components window of the NetIQ Aegis Setup wizard, select the following 

options:

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

Aegis Services
Resource Management Namespace Provider

5 If you want to change the location where the setup program installs Aegis, ensure you select a 
drive letter that exists on all nodes in the cluster, such as C:\. The setup program does not 
support installing Aegis on the drive you assigned to the Aegis resource group.

6 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the Aegis 
Server components, and then click Finish.

7 To verify a successful installation, check the installation log file on each passive node in the 
cluster. Typically, the log file is in the c:\temp\Aegis folder.

8 If the installation process failed on a passive node, complete the following steps:
8a Run the Aegis setup program on the node where the installation failed.
8b Select Install Aegis on a new node in the cluster (existing Aegis installation).

2.5.5 Installing Web Server Components in a Three-Tier Cluster Environment
These steps guide you through the process of installing components on the Web Server computer in a 
three-tier cluster environment.

NOTE

You only need to run the setup program on one node in the cluster. The setup program 
automatically installs the components on all other nodes in the cluster.
If you add a new node to the cluster, repeat these steps on the new node.

The setup program also creates cluster resources. The following table lists the components and their 
related cluster resources.

Component Related Cluster Resource

Operations Web site World Wide Web Publishing Service

NetIQ Aegis Business Services service NetIQ Aegis Business Services
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To install Web Server components in a three-tier cluster environment:

1 Disable the firewall on the Aegis Server computer.
If you do not disable the firewall, the Aegis setup program cannot locate the Aegis Server 
computer during the Web Server computer installation.

2 Log on with an Administrator account to the computer where you want to install the Web Server 
components.

3 Configure the Group Policy security settings on the Web Server computer to allow anonymous 
access.

4 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

5 Click Begin Setup.
6 On the Select Components window of the NetIQ Aegis Setup wizard, select the following 

components:

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

Web Server Components (complete feature)
Aegis Reporting

NOTE: In a cluster environment, the Aegis Reporting component allows you to point to the 
Reporting server computer. For more information about the Reporting server computer, see 
Section 2.5.2, “Installing Reporting Center in a Cluster Environment,” on page 37.

7 If you want to change the location where the setup program installs Aegis, ensure you select a 
drive letter that exists on all nodes in the cluster, such as C:\. The setup program does not 
support installing Aegis on the drive you assigned to the Aegis resource group.

8 Click Next.
9 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the Web 

Server components, and then click Finish.
10 To verify a successful installation, check the installation log file on each passive node in the 

cluster. Typically, the log file is in the c:\temp\Aegis folder.
11 If the installation process failed on a passive node, complete the following steps:

11a Run the Aegis setup program on the node where the installation failed.
11b Select Install Aegis on a new node in the cluster (existing Aegis installation).

12 Enable the firewall on the Aegis Server computer.
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2.5.6 Installing Aegis and Web Server Components in a Two-Tier Cluster 
Environment
These steps guide you through the process of installing components on a combined Aegis/Web 
Server computer in a two-tier cluster environment.

NOTE

You only need to run the setup program on one node in the cluster. The setup program 
automatically installs the components on all other nodes in the cluster.
If you add a new node to the cluster, repeat these steps on the new node.

The setup program also creates cluster resources. The following table lists the components and their 
related cluster resources.

To install Aegis Server and Web Server components in a two-tier cluster environment:

1 Log on with an Administrator account to the computer where you want to install the combined 
Aegis Server and Web Server components.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

3 Click Begin Setup.
4 On the Select Components window of the NetIQ Aegis Setup wizard, select the following 

options:

NOTE: If you are upgrading from a previous version, the setup program automatically selects 
the components to install.

Aegis Services
Web Server Components (complete feature)
Aegis Reporting

NOTE: In a cluster environment, the Aegis Reporting component allows you to point to the 
Reporting server computer. For more information about the Reporting server computer, see 
Section 2.5.2, “Installing Reporting Center in a Cluster Environment,” on page 37.

Resource Management Service

Component Related Cluster Resource

NetIQ Aegis Activity Broker service NetIQ Aegis Activity Broker

NetIQ Aegis Correlation Engine service [no related cluster resource]

NetIQ Aegis Engine service NetIQ Aegis Engine

NetIQ Aegis Namespace Provider NetIQ Aegis Namespace Provider

NetIQ Resource Management Namespace Provider NetIQ Resource Management Namespace Provider

Operations Web site World Wide Web Publishing Service

NetIQ Aegis Business Services service NetIQ Aegis Business Services
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5 If you want to change the location where the setup program installs Aegis, ensure you select a 
drive letter that exists on all nodes in the cluster, such as C:\. The setup program does not 
support installing Aegis on the drive you assigned to the Aegis resource group.

6 Click Next.
7 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the combined 

server components and the databases, and then click Finish.
8 To verify a successful installation, check the installation log file on each passive node in the 

cluster. Typically, the log file is in the c:\temp\Aegis folder.
9 If the installation process failed on a passive node, complete the following steps:

9a Run the Aegis setup program on the node where the installation failed.
9b Select Install Aegis on a new node in the cluster (existing Aegis installation).

2.6 Configuring the Operations Console on 
Windows Server 2008
If the operating system on your Web Server computer is Windows Server 2008 SP 2 (32-bit or 64-bit) 
or Windows Server 2008 R2, after you install the Web Server components, you need to configure IIS 
to support the Operations Console.

To configure IIS on the Web Server computer:

1 Click Start > All Programs > Administrative Tools > Server Manager.
2 In the left pane, expand Roles, and then click Web Server (IIS).
3 Click Add Role Services.
4 On the Add Role Services wizard, complete the following steps:

4a Expand Web Server > Common HTTP Features, and then click Static Content.
4b Expand Web Server > Application Development, and then click ASP.NET.

5 On the Add Role Services wizard, click Next, and then follow the instructions to complete the 
wizard.

6 Click Start > All Programs > Administrative Tools > Internet Information Services (IIS) 
Manager.

7 In the left pane, expand ComputerName > Sites > Default Web Site, where ComputerName is the 
name of your server computer, and then click Aegis.

8 Double-click Handler Mappings.
9 In the mappings list, select StaticFile, and then click Edit.

10 In the Module field, place the cursor in front of any existing handlers, and then type 
StaticFileModule,DefaultDocumentModule,.

11 Click OK.
12 In the left pane, click Default Web Site.
13 In the Actions pane, click Restart.
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2.7 Installing the Reporting Center Console Locally
These steps guide you through the process of installing the Reporting Center Console on a user’s 
computer. For more information about Reporting Center components, see the Reporting Guide for 
NetIQ Reporting Center.

To install the Reporting Center Console on a user’s computer:

1 Log on with an Administrator account to the computer where you want to install the Aegis 
components.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

3 Click Begin Setup.
4 On the Select Features window, select Aegis Reporting, and then click Next.
5 On the Prerequisites window, under Required Prerequisites, click NetIQ Reporting Center, 

and then click Install Prerequisite to start the NetIQ Reporting Center Setup wizard.
6 On the Feature Selection window, select Console, and then click Next.
7 Follow the instructions in the NetIQ Reporting Center Setup wizard until you finish installing 

the Reporting Center Console, and then click Finish.
8 Follow the instructions in the NetIQ Aegis Setup wizard until you finish configuring the 

Reporting Center Console, and then click Finish.

2.8 Installing the Configuration Console Locally
These steps guide you through the optional process of installing the Configuration Console on a local 
computer. For more information about installing the Configuration Console using ClickOnce 
deployment, see Section 3.10, “Starting the Configuration Console the First Time,” on page 55.

NOTE: Installing the Configuration Console locally creates a shortcut in the NetIQ > Aegis program 
group.

To install the Configuration Console locally:

1 Log on with an Administrator account to the computer where you want to install the Aegis 
components.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

3 Click Begin Setup.
4 On the Select Features window, select Configuration Console (optional local install), and then 

click Next.
5 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the 

Configuration Console, and then click Finish.
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2.9 Installing the Aegis Event Generator
These steps guide you through the process of installing the Aegis Event Generator on a local 
computer.

To install the Aegis Event Generator on a local computer:

1 Log on with an Administrator account to the computer where you want to install the Aegis 
components.

2 Run the Aegis setup program from the root folder of the Aegis installation kit.

NOTE: Ensure the installation kit is located on the local computer where you are running the 
setup program.

3 Click Begin Setup.
4 On the Select Features window, select Aegis Event Generator (optional), and then click Next.
5 Follow the instructions in the NetIQ Aegis Setup wizard until you finish installing the Aegis 

Event Generator, and then click Finish.

2.10 Uninstalling Aegis
If necessary, you can uninstall Aegis by completing the procedures in the following sections. These 
procedures remove all Aegis components from your environment.

To successfully uninstall Aegis, you must remove the components in the correct order. The following 
checklist specifies the correct order for uninstalling Aegis components.

NOTE: If the uninstallation program cannot completely remove any files or folders that are still in 
use, it will prompt you to restart your computer. When you restart the computer, the uninstallation 
program automatically removes the remaining files and folders.

Checklist Items

1. Uninstall all Aegis adapters. For more information, see Section 2.10.1, “Uninstalling Aegis 
Adapters,” on page 45.

2. Uninstall the components on the Web Server computer. For more information, see 
Section 2.10.2, “Uninstalling Web Server Components,” on page 45.

3. Uninstall the components on the Aegis Server computer. For more information, see 
Section 2.10.3, “Uninstalling Aegis Server Components,” on page 46.

4. Uninstall the Aegis database. For more information, see Section 2.10.4, “Uninstalling the 
Aegis Database,” on page 46.
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2.10.1 Uninstalling Aegis Adapters
Before you remove any other Aegis components, you must uninstall any Aegis adapters on the Aegis 
Server computer.

WARNING: Shared adapters communicate with multiple NetIQ products. For example, the NetIQ 
AppManager Integration Adapter (AppManager adapter) communicates with NetIQ Aegis and the 
NetIQ AppManager Operations Portal. Do not uninstall a shared adapter unless you no longer use all 
products with which it communicates.

To uninstall an Aegis adapter:

1 Log on to the Aegis Server computer with an administrator account.

NOTE: If you are uninstalling from a cluster environment, log on to a passive node in the 
cluster.

2 If you are uninstalling from a cluster environment, remove the computer from the cluster.
3 Close all open applications.
4 Open Control Panel and select Add or Remove Programs.
5 Select NetIQ Aegis Adapter for Product Name, where Product Name is the name of the product 

to which the adapter connects.
6 Click Remove.
7 If you are uninstalling from a cluster environment, complete the following steps:

7a Repeat Steps Step 1 through Step 6 on all passive nodes.
7b Repeat Steps Step 1 through Step 6 on the active node.

2.10.2 Uninstalling Web Server Components
After you remove all Aegis adapters, you can uninstall the Aegis components on the Aegis Server 
computer.

To uninstall Aegis components on the Web Server computer:

1 Log on to the Web Server computer with an administrator account.

NOTE: If you are uninstalling from a cluster environment, log on to a passive node in the 
cluster.

2 If you are uninstalling from a cluster environment, remove the node from the cluster. If you do 
not remove the node from the cluster, and a failover occurs, the failover might interfere with the 
uninstallation procedure.

3 Close all open applications.
4 Open Control Panel and select Add or Remove Programs.
5 Select NetIQ Aegis.
6 Click Remove.
7 If you are uninstalling from a cluster environment, complete the following steps:

7a Repeat Steps Step 1 through Step 6 on all passive nodes.
7b Repeat Steps Step 1 through Step 6 on the active node.
Installing Aegis 45



2.10.3 Uninstalling Aegis Server Components
After you remove all Aegis components on the Web Server computer, you can uninstall the Aegis 
components on the Aegis Server computer.

NOTE: If you are using Aegis in a two-tier configuration, you do not need to uninstall the Aegis 
Server components separately from the Web Server components. For more information about a two-
tier configuration, see Section 2.2.6, “Supported Configurations,” on page 19.

To uninstall Aegis components on the Aegis Server computer:

1 Log on to the Aegis Server computer with an administrator account.

NOTE: If you are uninstalling from a cluster environment, log on to a passive node in the 
cluster.

2 If you are uninstalling from a cluster environment, remove the node from the cluster. If you do 
not remove the node from the cluster, and a failover occurs, the failover might interfere with the 
uninstallation procedure.

3 Close all open applications.
4 Open Control Panel and select Add or Remove Programs.
5 Select NetIQ Aegis.
6 Click Remove.
7 If you are uninstalling from a cluster environment, complete the following steps:

7a Repeat Steps Step 1 through Step 6 on all passive nodes.
7b Repeat Steps Step 1 through Step 6 on the active node.

2.10.4 Uninstalling the Aegis Database
Completely removing Aegis from your enterprise requires removing the Aegis database from the 
Database Server computer. After you remove all Aegis components from the Aegis Server and Web 
Server computers, you can uninstall the Aegis database.

The setup program does not automatically remove the database. Use the Microsoft SQL Server 
administrator tools to remove the Aegis database from the Database Server computer. For more 
information about removing databases, see the Microsoft SQL Server documentation.

WARNING: Shared databases, such as the Resource Management and Reporting Center databases, 
provide data to multiple NetIQ products. For example, both NetIQ Aegis and NetIQ Directory and 
Resource Administrator use the Reporting Center database. Do not uninstall a shared database 
unless you no longer use all products that access it.

NOTE: If you are uninstalling from a cluster environment, ensure you remove the computer from the 
cluster before you perform the uninstallation procedure.
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3 3Getting Started

This chapter provides step-by-step procedures to help the Aegis Administrator get started in Aegis.

3.1 Aegis Administrator Checklist
The Aegis Administrator is responsible for installing, configuring, managing, and maintaining Aegis. 
The Aegis Administrator might also install Aegis adapters, manage security, and consult with 
discipline experts.

After installing Aegis, the Aegis Administrator needs to complete certain tasks to prepare Aegis for 
use. Use the following checklist to help you complete the tasks.

3.2 Configuring the NetIQ Mail Provider
The NetIQ Mail provider allows Aegis to monitor specific email accounts for new messages. When a 
new email message arrives, the NetIQ Mail provider sends an email event to Aegis. If the email event 
meets defined trigger criteria, the trigger initiates a work item.

NOTE: The NetIQ Mail provider monitors only the inbox for the specified email account. If you have 
message rules that move an incoming message to another folder, the NetIQ Mail provider cannot 
send an event for that message.

Checklist Items

1. Configure the NetIQ Mail provider. For more information, see Section 3.2, “Configuring the 
NetIQ Mail Provider,” on page 47.

2. Configure the NetIQ Aegis Adapter for Microsoft Exchange Server. For more information, see 
Section 3.3, “Configuring the Exchange Adapter,” on page 48.

3. Ensure the SQL Server Agent is running. For more information, see Section 3.4, “Verifying the 
SQL Server Agent is Running,” on page 51.

4. Enable or disable HTML code and links in user input forms. For more information, see 
Section 3.5, “Enabling or Disabling HTML in User Input Forms,” on page 52.

5. Register data sources. For more information, see the appropriate Adapter Guide.

6. Set up Aegis users. For more information, see Section 4.1, “Managing Users and Groups,” on 
page 57.

7. Configure security. For more information, see Section 4.3, “Managing Permission 
Assignments,” on page 61.

8. Set up resources and business services. For more information, see Chapter 5, “Managing 
Resources,” on page 63.
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Using the Aegis Adapter Configuration Utility, you can configure the NetIQ Mail provider to 
monitor email accounts on the following types of email servers:

Post Office Protocol version 3 (POP3)
Internet Message Access Protocol (IMAP)

NOTE

The NetIQ Mail provider supports Secure Socket Layer (SSL) for both POP3 and IMAP.
Ensure any application that accesses the email account, such as Microsoft Outlook, leaves a copy 
of incoming email messages on the server. If the application deletes email messages from the 
server, the NetIQ Mail provider cannot effectively monitor for new email events.
The POP3 protocol allows only one active connection per email account. Depending on how you 
implement the POP3 server, additional connections might disconnect Aegis from the mail 
server. If you want to configure another email client to connect to the email account, see your 
email administrator to determine the best alternative to the POP3 protocol.

To monitor a POP3 or IMAP email account:

1 In the email account you want to monitor, ensure the account is empty or contains only emails 
for which you want the NetIQ Mail provider to create events.

NOTE: When you configure the NetIQ Mail provider to monitor an email account, the provider 
creates an event for each email in the account, and then sends them to Aegis. If a Process Author 
has not created a workflow to match these events, the events do not initiate work items.

2 Log on to the Aegis Server computer with an Administrator account.
3 In the NetIQ program group, click Aegis > NetIQ Aegis Adapter Configuration Utility.
4 In the left pane, click Email Accounts.
5 On the Edit menu, click New Entry.
6 In the view pane, click Monitor an Internet email account.
7 Provide the appropriate information, and then click Exit.
8 Restart the NetIQ Aegis Namespace Provider service.

NOTE
If the Aegis Server computer is part of a cluster, restarting the NetIQ Aegis Namespace 
Provider service updates all nodes in the cluster.
If you do not restart the Namespace Provider service, the Configuration Console displays 
an error the next time you attempt to log on.

9 Restart any open instances of the Configuration Console to see the changes.

3.3 Configuring the Exchange Adapter
The NetIQ Aegis Adapter for Microsoft Exchange Server (Exchange adapter) allows Aegis to 
communicate with Exchange Server to:

Initiate work items as a result of an email sent to a particular mailbox
Send an email from a particular mailbox during the course of a workflow
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Pause a workflow and wait for an email sent to a particular mailbox
Extract and save attachments from an email

The Exchange adapter includes a library of workflow activities that Process Authors can use in the 
Workflow Designer. For more information about activities or activity libraries, see the Process 
Authoring Guide for Aegis.

The following table provides an overview of tasks to configure the Exchange adapter.

3.3.1 Configuring Microsoft Exchange Server
Before you configure the Exchange adapter on the Aegis Server computer, ensure the following:

The Exchange Server computer is in the same domain as the Aegis Server computer. If the two 
computers are not in the same domain, the Exchange Server computer does not recognize the 
Exchange adapter credentials. For more information about configuring domains in your 
environment, see the appropriate Microsoft documentation.
Your Exchange administrator creates an Exchange account for the Aegis application credentials. 
If an Exchange account does not exist for the Aegis application credentials, you cannot properly 
configure the profile in Outlook. For more information about the Aegis application credentials, 
see Section 2.2.5, “Understanding Aegis Application Credentials,” on page 18.

3.3.2 Installing and Configuring Microsoft Outlook
Before you configure the Exchange adapter on the Aegis Server computer, you must install and 
configure Outlook on the Aegis Server computer. For more information about installing Outlook, see 
the appropriate Microsoft documentation.

NOTE: If your Aegis Server computer belongs to a cluster, install Outlook on each node in the cluster.

After you install Outlook, you must configure the default profile, typically named Outlook, to use 
the Exchange account for the Aegis application credentials. When the Exchange adapter detects a 
new email in the mailbox, it sends an event to Aegis.

NOTE: NetIQ recommends you use only the default Outlook profile with the Exchange adapter. If 
you need to monitor more than one account, you can associate additional mailboxes with the 
Outlook profile. For more information about monitoring multiple mailboxes, see Section 3.3.3, 
“Monitoring Multiple Mailboxes,” on page 50.

Checklist Items

1. Configure the Exchange Server computer. For more information, see Section 3.3.1, 
“Configuring Microsoft Exchange Server,” on page 49.

2. Install Outlook and configure the profile. For more information, see Section 3.3.2, “Installing 
and Configuring Microsoft Outlook,” on page 49.

3. Configure the profile to monitor additional mailboxes. For more information, see Section 3.3.3, 
“Monitoring Multiple Mailboxes,” on page 50.

4. Enable the Exchange adapter. For more information, see Section 3.3.4, “Enabling the 
Exchange Adapter,” on page 51.
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To configure the profile in Outlook:

1 Log on to the Aegis Server computer using the Aegis application credentials.
2 Start Outlook.
3 In the configuration wizard, ensure the following values are set:

4 If the Aegis Server computer belongs to a cluster, repeat Steps Step 1 through Step 3 on each 
node in the cluster.

3.3.3 Monitoring Multiple Mailboxes
Using the Mail applet in Control Panel on the Aegis Server computer, you can associate additional 
mailboxes with the Outlook profile. When the Exchange adapter detects a new email in an associated 
mailbox, it sends an event to Aegis. For more information about adding additional mailboxes to the 
profile, see the appropriate Microsoft documentation.

NOTE

If the Mail applet is not available, ensure you have installed Microsoft Outlook and configured 
the default profile. For more information about configuring the profile, see Section 3.3.2, 
“Installing and Configuring Microsoft Outlook,” on page 49.
After you use the Mail applet to make changes, restart the Namespace Provider service.
If your Aegis Server computer belongs to a cluster, ensure you make the same changes to the 
Mail applet on each node in the cluster.

For each mailbox you associate with the profile, ensure your Exchange Administrator grants read 
and send privileges to the Exchange account for the Aegis application credentials.

WARNING

Any user that logs on to the Aegis Server computer using the Aegis application credentials and 
starts Outlook can see the email for all monitored mailboxes.
The size of the monitored mailboxes affects the response time of the Exchange adapter. NetIQ 
recommends deleting old emails from monitored mailboxes on a regular basis.

Option Value

E-mail Accounts Yes

Manually configure server 
settings or additional server 
types (2007 only)

On

Server Type (2003)

Choose E-mail Service (2007)

Microsoft Exchange Server (2003)

Microsoft Exchange (2007)

Microsoft Exchange Server The name of the Exchange Server computer, such as ExchServ01.

Use Cached Exchange Mode Off

User Name The name of the mailbox your Exchange administrator set up for the 
Aegis application credentials. For example, Aegis Admin.
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3.3.4 Enabling the Exchange Adapter
After you configure the Exchange Server computer and install Outlook on the Aegis Server 
computer, you can enable the Exchange adapter to monitor one or more mailboxes.

To enable the Exchange adapter:

1 Log on to the Aegis Server computer with an Administrator account.
2 In the NetIQ program group, click Aegis > NetIQ Aegis Adapter Configuration Utility.
3 In the left pane, click Email Accounts.
4 On the Edit menu, click New Entry.
5 In the view pane, click Monitor Microsoft Exchange Server accounts.
6 Provide a description, and then click Exit.
7 Restart the NetIQ Aegis Namespace Provider service.

NOTE
If the Aegis Server computer is part of a cluster, restarting the NetIQ Aegis Namespace 
Provider service updates all nodes in the cluster.
If you do not restart the Namespace Provider service, the Configuration Console displays 
an error the next time you attempt to log on.

8 If there are any open instances of the Configuration Console, restart them to see the changes to 

the NetIQ Mail provider.

3.4 Verifying the SQL Server Agent is Running
The following jobs require the SQL Server Agent to be running on the Database Server computer 
hosting the Aegis database.

Capture New Report Data 
Uses stored procedures to populate the reporting tables in the Aegis database on an hourly 
basis, starting one hour after Aegis initiates the first work item. If you run reports during the 
hour between jobs, the reports display data from the most recent instance of the job. If you run 
any reports in Reporting Center during the hour after the first work item, the reports will appear 
empty. If you require the most recent data in your reports, you can run the job manually. For 
more information about running the job manually, see Section 3.4.2, “Starting a Job Manually,” 
on page 52.

Purge Resources from Data Sources 
Removes unused resources from the Resource Management database according to the specified 
retention times. The job optionally hides computers that are not currently sending data to Aegis. 
For more information about retention time for resources and hiding inactive computers, see the 
Help for Global Administrator Settings on the Options window in the Configuration Console.

Hourly Cleanup 
Removes events, work items, and work item data from the Aegis database according to the 
specified retention times. The job removes unused events as well as events that are associated 
with work items. For more information about retention time settings for events and work items, 
see the Help for Global Administrator Settings on the Options window in the Configuration 
Console.
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3.4.1 Checking the Status of the SQL Server Agent
You can check the status of the SQL Server Agent at any time and, if necessary, start it manually.

To check the status of the SQL Server Agent:

1 Log on to the Database Server computer with an Administrator account.
2 Start Microsoft SQL Server Management Studio.
3 In the left pane, verify the SQL Server Agent is running.
4 If the SQL Server Agent is not running, right-click SQL Server Agent, and then click Start.
5 Click Yes.
6 On the File menu, click Exit.

3.4.2 Starting a Job Manually
The Capture New Report Data job runs hourly. If you want to populate the reporting tables before the 
regularly scheduled job, you can run it manually.

To run a job manually:

1 Log on to the Database Server computer with an Administrator account.
2 Start Microsoft SQL Server Management Studio.
3 In the left pane, expand SQL Server Agent > Jobs.
4 Right-click the job you want to start, and then click Start Job at Step.
5 On the Start Jobs window, review any messages.
6 If you receive an error message, in the Message field, click the link to see the details.
7 On the Start Jobs window, click Close.
8 On the File menu, click Exit.

3.5 Enabling or Disabling HTML in User Input Forms
By default, the Description field in user input forms supports HTML, including links. If your 
security policy does not allow for HTML links, you can disable the option in the Web.Config file.

To enable or disable HTML in user input forms:

1 Log on to the Web Server computer with an Administrator account.
2 Open the Web.Config file, typically located in the C:\Program Files\NetIQ\Aegis\website 

folder.
3 Set the AllowFormDescriptionLink value to one of the following:

True - Allows Process Authors to use HTML code in the Description field of user input 
forms. At run time, Process Operators can click any links.
False - Blocks HTML code. If a Process Author includes any formatting or links, a Process 
Operator sees only raw HTML code at run time.
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3.6 Modifying Aegis Repository Configuration
During installation, you specify the SQL Server computer that hosts the Aegis and Resource 
Management databases and the authentication method the providers use to communicate with them. 
After installation is complete, if you move the database to another host or modify the logon 
credentials, the providers cannot communicate with the databases. You must manually update the 
host information or logon credentials in the Aegis Adapter Configuration Utility.

To update the location or logon credentials for a database:

1 Log on to the Aegis Server computer with an Administrator account.
2 Stop the following services:

NetIQ Aegis Activity Broker
NetIQ Aegis Correlation Engine
NetIQ Aegis Engine
NetIQ Aegis Namespace Provider

3 If the Aegis Server and Web Server are on the same computer in your environment, stop the 
NetIQ Aegis Business Services service.

4 If you are moving a database to another server computer, complete the following steps:
4a Log on to the Database Server computer with an Administrator account.
4b Stop the database you want to move.
4c Perform a full backup of the database.
4d Log on to the new server computer with an Administrator account.
4e Restore the backup on the new server computer.

5 To install the SQL Server Agent jobs on the new Database Server computer, perform the 
following steps:
5a On the Aegis Server computer, open a command prompt for each of the following locations:

C:\Program Files\NetIQ\Aegis\DB\PGE

C:\Program Files\NetIQ\Aegis\DB\RPT

C:\Program Files\NetIQ\Aegis\iqrmdb\IQRM

5b For each location, type the following command:
sqlcmd -b -S Server -U "SqlUser" -P "SqlPwd" -i InstallJobs.sql
Where:

Server is the name of the new Database Server computer, including the instance, such 
as HOUAE001\Instance1.
SqlUser andSqlPwd are the user name and password for SQL authentication. If you use 
Windows authentication, do not include these options in the command.

6 On the Aegis Server computer, in the NetIQ program group, click 
Aegis > NetIQ Aegis Adapter Configuration Utility.

7 In the left pane, expand Aegis Repositories, and then click the database you want to update.
8 In the view pane, provide the new server location or logon credentials, and then click Test 

Database Connection.
9 If the test connection is successful, click Exit.
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10 Restart the following services:
NetIQ Aegis Activity Broker
NetIQ Aegis Correlation Engine
NetIQ Aegis Engine
NetIQ Aegis Namespace Provider

11 If the Aegis Server and Web Server are on the same computer in your environment, restart the 
NetIQ Aegis Business Services service.

12 If you moved a database to another server computer, make a backup copy of the old database 

before you delete it.

3.7 Modifying Aegis Application Credentials
During the installation process, the Aegis Administrator specifies the default user account Aegis uses 
to operate the following Aegis accounts:

Service account
Resource Management account
Default Aegis Administrator account

After installation is complete, if the user account changes in any way, such as a new password, the 
services cannot authenticate their communication with each other and the adapters cannot 
communicate with the Resource Management provider. You must manually update the account 
information for the service account and the Resource Management account.

For more information about Aegis application credentials, see Section 2.2.5, “Understanding Aegis 
Application Credentials,” on page 18.

3.7.1 Updating the Service Account
If the user account associated with the service account changes in any way, such as a new password, 
you must manually update the user account associated with the services.

NOTE: You can associate a different account with the services without affecting the Resource 
Management account or the default Aegis Administrator account. The services must all use the same 
account.

To update the service account:

1 Log on to the Aegis Server computer with an Administrator account.
2 On the Start menu, click Control Panel > Administrative Tools > Services.
3 Update the appropriate account information for each of the following services:

Aegis Engine
Activity Broker
Namespace Provider

4 Restart the Namespace Provider service. The Namespace Provider service automatically restarts 
the Aegis Engine and the Activity Broker services.
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3.7.2 Updating the Resource Management Account
If the user account associated with the Resource Management account changes in any way, such as a 
new password, you must manually update the account in the Adapter Configuration Utility.

NOTE: You can associate a different account with the Resource Management account without 
affecting the service account or the default Aegis Administrator account.

To update the Resource Management account:

1 Log on to the appropriate computer with an Administrator account.
2 In the NetIQ program group, click Aegis > NetIQ Aegis Adapter Configuration Utility.
3 In the left pane, expand Resource Management, and then click the name of the Aegis Server.
4 In the view pane, modify the appropriate information, and then click Exit.
5 Restart the Namespace Provider service. The Namespace Provider service automatically restarts 

the Aegis Engine and Activity Broker services.

3.8 Running the Configuration Console in a Different Domain
By default, the BSL and the Configuration Console must be running on computers in the same 
domain or in domains that trust each other. If you have users that need to run the Configuration 
Console on a computer that is not in a trusted domain, you can configure the BSL to use SOAP 1.1 to 
communicate securely with the Configuration Console. For more information about configuring the 
BSL to use SOAP 1.1, contact Support.

3.9 Understanding Database Recovery
Many of the operations in the Configuration Console and the Workflow Designer communicate with 
one of the databases connected to Aegis. If you perform a step that cannot connect to the appropriate 
database, Aegis attempts to immediately reconnect. If the attempt is unsuccessful, Aegis tries again 
in 90 seconds.

WARNING: If you receive a database connection error when you attempt to commit a change to a 
database, such as a new workflow, do not shut down or cancel, or you may lose the data. Wait 90 
seconds and try again to save your changes.

3.10 Starting the Configuration Console the First Time
The Configuration Console is a Windows-based application delivered to your desktop using 
Microsoft ClickOnce publishing and deployment technology. To start the console the first time, 
launch it from the Operations Console. The initial ClickOnce deployment creates a shortcut in the 
NetIQ program group.

NOTE: If your environment does not allow ClickOnce installation, you can install the Configuration 
Console locally on any computer. For more information about installing the Configuration Console 
locally, see Section 2.8, “Installing the Configuration Console Locally,” on page 43.
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To launch the Configuration Console from the Operations Console:

1 If you are logged on to the Web Server computer, on the Start menu, click 
All Programs > NetIQ > Aegis, and then click NetIQ Aegis Operations Console.

2 If you are logging on to the Operations Console remotely, complete the following steps:
2a Start Internet Explorer.
2b Specify the following URL, where hostcomputer is the name of the Web Server computer:

http://hostcomputer/Aegis
3 On the Operations Console Login window, log on as a member of the Aegis Administrators 

group.
4 If you are logging on for the first time after installation, log on with the user account specified 

during installation.
5 To ensure the local computer has the prerequisites for installing the Configuration Console, 

complete the following steps:
5a Click Configuration Console Prerequisites.
5b If you need to install the prerequisites, click Install Prerequisites.
5c Close the NetIQ Aegis Configuration Console Prerequisites window.

6 Click Launch Configuration Console.
7 On the Configuration Console Login window, log on as a member of the Aegis Administrators 

group.

3.11 Switching Users
If you select the Sign me in automatically check box on the Configuration Console logon screen, 
Aegis bypasses the logon screen the next time you start it. If you want to log on as a different user, 
you can do either of the following:

In the Configuration Console, click Exit and Sign Off. The next time you start the Configuration 
Console, Aegis displays the logon screen.
Before you start Aegis, press and hold Ctrl+Shift. Aegis displays the logon screen instead of 
opening the Configuration Console.
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4 4Configuring Aegis Security

Aegis collects information across your enterprise, allowing people in a number of different roles to 
use and benefit from using that information. Security settings control who can access the Aegis 
interfaces and which activities each user can perform.

4.1 Managing Users and Groups
Aegis supports imported user and group accounts from both Active Directory (AD) and the local 
Security Account Manager (SAM) database on the Aegis Server computer, as well as internal Aegis 
users and groups. You cannot modify the imported user and group accounts in Aegis, but you can 
configure Aegis to automatically synchronize the accounts with any changes made in AD and the 
SAM database. For more information about account synchronization, see Section 4.1.2, 
“Understanding User and Group Synchronization,” on page 58.

4.1.1 Default Groups
Aegis provides the following default groups, each of which is associated with a default permission 
set at the global level to determine product access. For more information about default permission 
sets, see Section 4.2.1, “Default Permission Sets,” on page 60.

Administrators 
Aegis imports the local Administrators group during the installation procedure and associates 
the group with the Aegis Administration permission set. 

Aegis Administrators 
User and group accounts associated with the Aegis Administrators group have the permissions 
to perform all Aegis functions.
Aegis Administrators typically install Aegis and Aegis adapters. Aegis Administrators interact 
with the Configuration Console and the Adapter Configuration Utility to configure, manage, 
and maintain Aegis, including security and user setup. They might also be responsible for 
consulting with discipline experts.

Aegis Managers 
User and group accounts associated with the Aegis Managers group have all the permissions 
associated with the Aegis Management permission set.

Aegis Users 
User and group accounts associated with the Aegis Users group have all the permissions 
associated with the Resource Viewing permission set. Aegis adds all imported users to the Aegis 
Users group.
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Process Authors 
User and group accounts associated with the Process Authors group have all the permissions 
associated with the Process Authoring, Process Operation, and Process Viewing permission sets.
Process Authors interact mainly with the Workflow Designer to create and maintain triggers, 
triggering event definitions, and process workflows.

Process Operators 
User and group accounts associated with the Process Operators group have all the permissions 
associated with the Process Operation and Process Viewing permission sets.
Process Operators interact mainly with the Operations Console to:

View processes and associated work items, including activity details, related events, and 
supporting analysis.
Manually trigger work items. For example, an HR manager can trigger a workflow to create 
a new account for a new employee.
Monitor and supply input to active work items.
Terminate work items.

Process Operators can also use the Configuration Console to view processes and workflow 
revisions.

Process Viewers 
User and group accounts associated with the Process Viewers group have all the permissions 
associated with the Process Viewing permission set.

4.1.2 Understanding User and Group Synchronization
By default, Aegis periodically checks AD and the SAM database for changes to imported user and 
group accounts. If Aegis detects changes to the attributes it supports, it automatically synchronizes 
imported accounts with the updated attributes. Aegis also retrieves the groups to which the imported 
user and group accounts belong in AD and the SAM database, which allows Aegis to correctly 
handle permission assignments to parent groups.

To synchronize domain accounts, ensure the Aegis Namespace Provider service account has at least 
read privileges for the specified domain. If the service account does not have proper rights in the 
domain, Aegis cannot synchronize attributes and parent groups for domain accounts, which 
prevents Aegis from displaying the associated parent groups in the Configuration Console. For more 
information about the service account, see Section 2.2.5, “Understanding Aegis Application 
Credentials,” on page 18. For more information about synchronizing user and group accounts in a 
one-way trust, see “Trusted Domains” on page 21.

NOTE

If a user account’s group memberships change while the user is logged on to the Configuration 
Console, the user must log off and log back on to see the changes.
If a group account’s group memberships change while a member of the group is logged on to the 
Configuration Console, the user must log off and log back on to see the changes.
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If you disable automatic synchronization, you must manually synchronize user and group accounts 
to import any changes.

To manually synchronize imported user and group accounts:

1 In the Navigation pane, click Security.
2 In the left pane, click one of the following:

Users
Groups

3 In the view pane, select the account you want to synchronize.
4 In the User Tasks or Group Tasks list, click Synchronize Now.

4.1.3 Importing Local Users
You can import local SAM user accounts from the SAM database on the computer where the 
Resource Management provider is running, typically the Aegis Server computer.

To import local SAM user accounts:

1 In the Navigation pane, click Security.
2 In the left pane, click Users.
3 In the User Tasks list, click Import Local Users.
4 On the Import Local Users window, select the local users you want to import into Aegis, and 

then click Import.

4.1.4 Importing Local Groups
You can import local SAM accounts from the SAM database on the computer where the Resource 
Management provider is running, typically the Aegis Server computer.

To import local SAM groups:

1 In the Navigation pane, click Security.
2 In the left pane, click Groups.
3 In the Group Tasks list, click Import Local Groups.
4 On the Import Local Groups window, select the local groups you want to import into Aegis, and 

then click Import.

4.1.5 Creating an Aegis Group
You can create internal Aegis groups if there are no AD or SAM groups that suit your needs. Aegis 
groups allow you to group users and groups without having to modify any AD or SAM settings.

To create an Aegis group:

1 In the Navigation pane, click Security.
2 In the left pane, click Groups.
3 In the Group Tasks list, click Create Aegis Group.
4 On the General tab of the Create Aegis Group window, provide the appropriate information, 

and then click OK.
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4.2 Managing Permission Sets
Permission sets control access to specific Aegis features. You can use permission sets to allow or deny 
users the ability to perform particular actions at the global level, such as creating process workflows, 
or at the object level, such as modifying a specific process or providing input to a specific input form. 
Users and groups are not members of a particular permission set. Instead, you associate users and 
groups with permission sets at the global level, the object level, or both, by creating permission 
assignments. For more information about permission assignments, see Section 4.3, “Managing 
Permission Assignments,” on page 61.

NOTE: When you update a permission set, the change filters down to all users and groups associated 
with it through permission assignments.

4.2.1 Default Permission Sets
Aegis provides the following default permission sets, each of which is associated with a default Aegis 
group at the global level to determine product access. For more information about default groups, see 
Section 4.1.1, “Default Groups,” on page 57.

Aegis Administration 
User and group accounts associated with the Aegis Administration permission set can use the 
Configuration Console, the Workflow Designer, and the Operations Console. Aegis 
Administrators install, configure, manage, and maintain Aegis. Aegis Administrators may also 
be responsible for tasks not affected by permission sets, such as installing adapters for data 
sources and consulting with discipline experts.

Aegis Management 
User and group accounts associated with the Management permission set can enable developer 
functionality in the Workflow Designer and create, modify, and delete activity libraries.

All Denied 
User and group accounts associated with the All Denied permission set at the global level cannot 
log on to Aegis. User and group accounts associated with the All Denied permission set at the 
object level cannot view or modify a particular object, such as a process or a trigger.

Resource Viewing 
User and group accounts associated with this permission set have minimal permissions so they 
can retrieve configuration information for Aegis services.

Process Authoring 
User and group accounts associated with the Process Authoring permission set can use the 
Configuration Console, the Workflow Designer, and the Operations Console. Process Authors 
create and maintain triggers and process workflows. They can also enable developer 
functionality in the Workflow Designer.

Process Operation 
User and group accounts associated with the Process Operation permission set can use the 
Operations Console to manually trigger work items, monitor and supply input to active work 
items, and terminate work items. They can use the Configuration Console to view processes and 
workflow revisions.
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Process Viewing 
User and group accounts associated with the Process Viewing permission set can use the 
Operations Console to view processes and associated work items, including activity details, 
related events, and supporting analysis.

4.2.2 Granting Process Authoring Permissions
If you create a new permission set for Process Authors, include the following minimum permissions:

Can Create/Delete Process
Can Modify Process
Can Modify Workflow Revision
Can View Process
Can View Workflow Revision

4.2.3 Creating a Permission Set
You can create new permission sets to determine user access to Aegis.

To create a new permission set:

1 In the Navigation pane, click Security.
2 In the left pane, click Permission Sets.
3 In the Permission Set Tasks list, click Create New Permission Set.
4 On the General tab of the Create New Permission Set window, provide the appropriate 

information, and then click OK.

4.3 Managing Permission Assignments
A permission assignment is the combination of a user or group and a permission set. For more 
information about permission sets, see Section 4.2, “Managing Permission Sets,” on page 60. You may 
create permission assignments for users and groups at the global level, the object level, or both. For 
example, a group may have a global permission assignment that associates it with the Process Author 
permission set, granting all users in the group permission to create and modify processes. However, 
if a user in the group is associated with a custom Read-Only permission set for a specific process (the 
object level), that user is not allowed to modify that process.

NOTE: When a user or group has multiple permission assignments that conflict, the more restrictive 
permission assignment always takes precedence.
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4.3.1 Configuring Global Permission Assignments
Global security settings determine user and group access to Aegis and all of its functionality. For 
example, users that create processes need to be associated with the Process Author permission set at 
the global level.

To configure global security:

1 In the Global Tasks list, click Configure Global Security.
2 On the Global Security window, click Add.
3 Under New Permission Assignment, select the appropriate combination of permission set and 

user or group, and then click Add.
4 To complete the permission assignment, click OK.

4.3.2 Configuring Object Permission Assignments
Object security settings determine user and group access to specific objects in Aegis, such as 
processes, triggers, and resource groups. For example, a Process Author can be denied access to a 
particular process by configuring the object-level security settings for that process.

Creating object-level permission assignments restricts the object to accepting only those permission 
assignments. For example, when you create a permission assignment on Process X that grants 
Process Authoring permissions to User A, User A becomes the only user with those permissions, 
except for Aegis Administrators. Aegis denies access to all other users unless you create a new 
permission assignment for them or remove all other permission assignments from Process X.

NOTE: Object security settings override global settings as long as they are more restrictive. For 
example, you cannot grant users permission to edit a process in the Configuration Console if they 
have been denied Process Author permissions at the global level.

To configure object-level security:

1 On the Security tab of the appropriate window, click Add.
2 Under New Permission Assignment, select the appropriate combination of permission set and 

user or group, and then click Add.
3 To complete the permission assignment, click OK.
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5 5Managing Resources

The NetIQ Resource Management database is a common resource repository for all NetIQ and third-
party products that connect to Aegis as data sources. Aegis can connect to multiple product adapters, 
each of which supports multiple data sources. For example, the AppManager adapter supports 
multiple repositories for both AppManager and Control Center.

These topics provide guidance for using the Aegis Configuration Console to manage your resources 
in the Resource Management database.

5.1 Understanding Resources
A resource is anything that can be managed, such as a computer or a cluster. For example, when you 
connect an adapter to Aegis, the Resource Management database creates a resource record for each of 
the computers used by the connected data sources, such as AppManager. In some cases, multiple 
data sources might register a single resource. For example, a computer might be a resource in both an 
AppManager repository and a NetIQ Secure Configuration Manager repository, with each repository 
identifying the computer by a different name. The Resource Management database provides a way to 
identify both instances of the computer with a common identifier, creating associated resources that 
automatically correlate resource information from multiple data sources. Aegis attempts to associate 
resources automatically if there is matching information, such as identical IP addresses. However, if 
Aegis is unable to find matching information, you must associate them manually.

NOTE: Removing a computer from a data source repository does not delete the record in the 
Resource Management database. If a computer resource receives no updates from the data source 
repository for 30 days, the Resource Management database hides the resource record.

You can create a resource in the database, and then add it to any number of resource groups, or you 
can create a resource directly in an existing resource group. For more information about resource 
groups, see Section 5.1.1, “Understanding Resource Groups,” on page 63.

5.1.1 Understanding Resource Groups
A resource group contains resources with similarities, such as all computers that perform a particular 
function. When you connect an adapter to Aegis, the Resource Management database creates 
resource groups for each data source. For example, if AppManager is a data source, the Resource 
Management database creates a resource group for each of the following:

Server Group
Standard View
Snapshot View
Dynamic View
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For more information about resources, see Section 5.1, “Understanding Resources,” on page 63. For 
more information about AppManager repositories, see the Administrator Guide for NetIQ AppManager.

NOTE

You can use a resource group in a business service. For more information about business 
services, see Section 5.2, “Understanding Business Services,” on page 65.
If the Resource Management database finds multiple resource groups with the same name from 
different data sources, Aegis combines them into one resource group.
Resource groups can contain other resource groups with unlimited nesting levels.

Resource groups allow Aegis processes to respond to events at the resource group level instead of on 
the resource level. For example, when creating a named event that evaluates incoming events from 
Exchange servers, you can specify the Exchange Servers resource group in the named event instead 
of having to specify each individual computer. If you add a new Exchange server, you only need to 
update the resource group. The named event remains unchanged. For more information about 
named events, see the Process Authoring Guide for NetIQ Aegis.

5.1.2 Associating Resources
Associated resources represent a single resource that has been registered multiple times. For 
example, a computer can be registered as both an AppManager resource and a Security Manager 
resource. Associating them ties them together as the same resource.

Aegis will attempt to automatically associate resources if there is matching information. However, if 
Aegis is unable to find matching information, you must associate them manually.

To manually associate resources:

1 In the Navigation pane, click Resources.
2 If you know which resource group contains the resource you want to associate, complete the 

following steps:
2a In the left pane, select the appropriate resource group.
2b In the view pane, click the resource you want to associate.
2c Under Resource Details, click the Associated Resources tab.

3 If you do not know which resource group contains the resource you want, complete the 
following steps:
3a In the left pane, click All Computers.
3b In the view pane, click the resource you want to associate.
3c Under Computer Details, click the Associated Resources tab.

4 In the Associated Resource Tasks list, click Add Associations.
5 On the Add Associations window, enter your search criteria, and then click Search.
6 In the Search Results list, click the resource you want to associate, and then click Add.
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5.2 Understanding Business Services
A business service is a collection of systems that fulfills a business need, such as a messaging service. 
A business service contains one or more resource roles, each of which contains one or more 
computers and/or resource groups that perform a particular role in the business service.

For example, in the previous graphic, Messaging Service includes the following resource roles:

Exchange Front End Servers
Exchange Back-end Servers
Blackberry Servers
Virus Scanning Servers
Spam Filtering Servers

Business services allow Aegis processes to respond to events at the business service level instead of 
the resource level. For example, when creating a named event that evaluates incoming events for 
messaging-related problems, you can specify the Messaging Service business service instead of 
having to specify each individual computer. If you add a new Exchange server to your environment, 
you only need to update the appropriate resource role. The named event remains unchanged. For 
more information about named events, see the Process Authoring Guide for NetIQ Aegis.

You may also assign user roles to the business service, such as Admin, Owner, or Stakeholder. The 
users or user groups associated with the user roles have a level of responsibility to the business 
service.
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NOTE

Resource roles are not unique in the database. If multiple business services have resource roles 
with the same name, they are not the same resource role.
User roles are unique in the database. If multiple business services have user roles with the same 
name, they are the same user role.

Upon installation, the Resource Management database creates business services according to settings 
in the data source, such as the AppManager Control Center Console.

5.2.1 Creating a Business Service
You can create a business service in the database, and then add it to any number of resource folders, 
or you can create a business service directly in an existing resource folder. For more information 
about resource folders, see Section 5.3, “Understanding Resource Folders,” on page 67.

NOTE: You can add the same business service to multiple resource folders.

5.2.2 Associating a Resource or Resource Group with a Resource Role
After you create a resource role for a business service, you can associate resources or resource groups 
with it.

To associate resources or resource groups with a resource role:

1 In the Navigation pane, click Resources.
2 In the left pane, select the business service with the resource role to which you want associate a 

resource or resource group.
3 Under Business Service Roles, click the Resource Roles tab.
4 Click the role to which you want associate a resource or resource group.
5 In the Resource Role Tasks list, click Associate Resources with Role.
6 On the Search for Resources window, enter your search criteria, and then click Search.
7 In the Search Results list, click one or more resources or resource groups, and then click Add.
8 To see the resources associated with the role, click the + next to the role name.

5.2.3 Associating a User or User Group with a User Role
After you create a user role for a business service, you can associate users or user groups with it.

To associate users or user groups with a user role:

1 In the Navigation pane, click Resources.
2 In the left pane, select the business service with the user role to which you want associate a user 

or user group.
3 Under Business Service Roles, click the User/Group Roles tab.
4 Click the role to which you want associate a use or user group.
5 In the User/Group Role Tasks list, click Associate Users/Groups with Role.
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6 On the Available Users/Groups window, click one or more users or user groups, and then click 
OK.

7 To see the users or user groups associated with the role, click the + next to the role name.

5.3 Understanding Resource Folders
Resource folders allow you to organize your resource groups and business services in the way that 
best suits your needs. For more information about resource groups and business services, see 
Section 5.1.1, “Understanding Resource Groups,” on page 63 and Section 5.2, “Understanding 
Business Services,” on page 65.

5.3.1 Creating a Resource Folder
You can create new resource folders to organize your resource groups and business services. 
Resource folders can contain other resource folders.

To create a new resource folder:

1 In the Navigation pane, click Resources.
2 If you want to create the new folder in an existing folder, click the appropriate folder in the left 

pane.
3 On the Action menu, click Create New Resource Folder.
4 On the General tab of the Create New Resource Folder window, provide the appropriate 

information, and then click OK.

5.3.2 Moving a Resource Folder
You can move a resource folder into another resource folder.

To move a resource folder into another resource folder:

1 In the Navigation pane, click Resources.
2 In the left pane, select the resource folder that you want to move.
3 Use drag and drop to move the resource folder to another resource folder.
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A AUsing the Filter Builder

In the Configuration Console, you can filter the data in the various lists. This appendix provides step-
by-step guidance for using the Filter Builder window.

A.1 Understanding Filter Builder Operators
The Filter Builder uses the following operators to tie descendant rules together and govern how they 
are related using Boolean logic:

AND returns records that match a combination of the following conditions
OR returns records that match any or all of the following conditions
NOT AND returns records that do not match a combination of the following conditions
NOT OR returns records that do not match any of the following conditions

A.2 Creating a Filter with the Filter Builder
Using the Filter Builder window, you may create a filter on any grid in the Configuration Console.

To create a filter using the Filter Builder window:

1 On any grid in the Configuration Console, click Edit Filter. By default, the Filter Builder 
displays the And operator with one condition.

2 If you want to change the operator, click And (red), and then select a new one from the list.
3 To set up a condition, complete the following steps:

3a To change the condition column, click [ColumnName] (blue), and then select a new one 
from the list.

3b To change the condition operator, click Begins with (green), and then select a new one from 
the list.

3c To change the condition value, click <enter a value> (gray) and type a new one.
4 To add another condition, click the + icon next to the operator.
5 If you want to delete a condition, click the x icon next to it.
6 To add a nested condition group, click the operator, and then click Add Group.
7 If you want to delete a nested condition group, click the group’s operator, and then click 

Remove Group.
8 To clear all conditions, click the first operator, and then click Clear All.
9 If you want to see the filter’s results without closing the Filter Builder, click Apply.

10 Click OK.
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A.3 Editing a Filter with the Filter Builder
Using the Filter Builder window, you may edit a filter on any grid in the Configuration Console.

To edit an existing filter using the Filter Builder window:

1 On any grid in the Configuration Console that has an applied filter, click Edit Filter.
2 To change the operator (red), click it, and then select a new one from the list.
3 To edit a condition, complete the following steps:

3a To change the condition column (blue), click it, and then select a new one from the list.
3b To change the condition operator (green), click it, and then select a new one from the list.
3c To change the condition value (black), click it, and then type a new one.

4 To add another condition, click the + icon next to the operator.
5 If you want to delete a condition, click the x icon next to it.
6 To add a nested condition group, click the operator, and then click Add Group.
7 If you want to delete a nested condition group, click the group’s operator, and then click 

Remove Group.
8 To clear all conditions, click the first operator, and then click Clear All.
9 If you want to see the filter’s results without closing the Filter Builder, click Apply.

10 Click OK.
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